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Legal information
Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.
DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.
WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.
CAUTION
indicates that minor personal injury can result if proper precautions are not taken.
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:
WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended or
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described.
Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Notes on the TIA Portal
1.1

1

General notes
The information in this readme file supersedes statements made in other documents.
Read the following notes carefully because they include important information for installation
and use. Read these notes prior to installation.

Display of Asian characters in the TIA Portal
Due to a change in behavior in Microsoft Windows, it may occur that texts are not displayed
correctly in the TIA Portal when a Chinese TIA Portal is installed on another Asian operating
system (e.g. Korean). To view the texts in TIA Portal correctly, open the Windows Control
Panel and select "English" under "Language for non-Unicode programs". Note, however, that
this may cause display problems in other programs.

Installing new .Net versions or .Net service packs
● Close the TIA Portal before installing a new .Net version or a new .Net service pack on your
programming device/PC.
● Restart the TIA Portal only after successful installation of the new .Net version or the
new .Net service pack.

Notes on handling
● If a project in the list of projects last used is located on a network drive that is not connected,
you may experience delays when opening the "Project" menu.
● When you insert a CPU, you may need to wait for some time if the project editor is open at
the same time. This generally takes longer when you insert the first CPU in a newly created
project. To be able to continue working more quickly, you should close the project editor
before inserting a CPU.
● The alarm "Application is not responding" may appear in Windows 7 with functions that
take a long time to run (loading the CPU for example). If this occurs, wait until the function
has correctly finished.
● If you have installed a Microsoft mouse with IntelliPoint, you may find that it superimposes
components over the buttons of the title bar. If this is the case, uninstall the IntelliPoint
software from Microsoft.
● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. In
this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver.
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Notes on the TIA Portal
1.1 General notes

Using the TIA Portal via a remote desktop
In principle, it is possible to use the TIA Portal via a remote desktop connection. During
configuration, you should, however, avoid disconnecting the connection to the desktop client.
In rare cases, this can lead to the software user interface being blocked.
If you experience this blockage, follow these steps on the desktop client.
1. Open the Windows Task-Manager and close the "rdpclip.exe" process.
2. Type in "rdpclip.exe" in the command prompt to restart the process.
Note that the current content of the clipboard will be lost. You can, however, then continue
configuration as usual. To be on the safe side, you should restart the TIA Portal at the next
opportunity.

Migration of projects with the TIA Portal
After the migration of hardware configurations and program blocks from earlier automation
solutions, first check the functionality of the migrated project before you use it in productive
operation.

Working with automatically synchronized network drives
Automatic synchronization after a network interruption can result in current (local) project data
being stored as a "backup" on the network drive through user interactions. This could cause
outdated project data to be loaded from the network drive when opening the project. For this
reason, we do not recommend that you store TIA Portal projects on synchronized network
drives.
If, however, you do work on synchronized drives, you can continue working locally in the event
of a network interruption. In this case, you must always ensure that the TIA Portal application
is closed while data is synchronized. The synchronization itself must be implemented in such
a way that the current (local) project data replaces the project data on the network drive.

Entry of decimal places
With certain Windows language settings, it may occur that the entry of values with a comma
as decimal place is not recognized (entering "1,23" leads to an error). Instead, use the
international format ("1.23").

Information on the TIA Portal in online support
Overview of the most important technical information and solutions for the TIA Portal in the
Siemens Industry online support.
Internet link: TIA Portal in Siemens Industry online support (www.siemens.com/industry/
onlinesupport/tiaportal)
All information on service and support in the Siemens Industry online support:
Internet link: Service and support in Siemens Industry online support (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002)
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Notes on the TIA Portal
1.3 Notes on memory cards
Here, you can also subscribe to the newsletter that provides you with latest information relating
to your products.

Starting the TIA Portal
When you start the TIA Portal, Windows attempts to update the Certificate Revocation List
(CRL) of "windowsupdate.com".
If no Internet access is available and there are multiple DNS servers, a timeout may occur and
delay the start of the TIA Portal.

1.2

Notes on libraries

Contents
Information that could not be included in the online help and important information about
product characteristics.

Comparing library elements
If master copies and types have the same name, the corresponding objects in the project are
overwritten when the action "Copy" is used. Please note that this takes place without a prompt.
The same behavior occurs when the name of the master copy is different to the name of the
type, but an object within the master copy has the same name as the type.

1.3

Notes on memory cards

Contents
Information that could not be included in the online help and important information about
product characteristics.

Notes on SIMATIC memory cards
The SIMATIC memory cards have been formatted and set up by Siemens for use with S7-1200
and S7-1500 modules. This format must not be overwritten; otherwise, the card will no longer
be accepted by the modules. Formatting with Windows tools is therefore not permitted.

Behavior in case of open force job
Note that an active force job is retained even after you have loaded a new project to the
SIMATIC memory card. This means you should first delete the active force job before you
remove a SIMATIC memory card from the CPU and before you overwrite the card in the PC
with a new project. If you use a SIMATIC memory card with unknown content, you should
format the SIMATIC memory card before the next download.
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Notes on the TIA Portal
1.4 Notes on the hardware configuration

Access protection for memory cards in USB card readers
By improving the security mechanisms for online access and engineering of S7-1500 CPUs,
the data storage on memory cards has been changed. For this reason, this version of STEP
7 cannot evaluate the passwords of the configured protection level when reading project data
from memory cards that is accessed via a USB card reader. The changed behavior affects the
memory cards for CPUs of the S7-1200/1500 series. Therefore, use physical safeguards to
protect critical project data on memory cards for these devices.
Note
This restriction is not related to online access to devices or the know-how protection of program
blocks.

1.4

Notes on the hardware configuration

Content
Information that could not be included in the online help and important information about
product characteristics.

Subnet addressing for CP 1613 and CP 1623
CP 1613 and CP 1623 are communication modules with microprocessor. To ensure secure
management of communication links, these are processed on the module. The protocol stack
in your PC is used for diagnostic purposes (SNMP, DCP). To allow both protocol stacks (i.e.
CP 1613/23 Firmware and CP 1613/23 NDIS access) access to the same partners, is
recommended to place both stacks of a module in the same subnet.

Editing a device IP address
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP
address. If necessary, this address range is automatically assigned by the system to a
programming device. Depending on the subnet mask, this applies also for all network classes.

Drivers for the CP 5512 communications processor
The drivers for the CP 5512 are no longer included in this software version. If you want to use
the CP 5512, the following needs to be installed prior to the installation of this software:
http://support.automation.siemens.com/WW/view/78453460 (http://
support.automation.siemens.com/WW/view/en/78453460)
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Notes on the TIA Portal
1.6 Notes on online and diagnostics
Please note that the CP 5512 can be used with a maximum of Windows 7 32-bit. As of Windows
8 or with 64-bit operating systems, the CP 5512 is not compatible.
Note
Since 2009, the functional successor the USB 2.0 module CP 5711 has been available.

1.5

Notes on instructions

Contents
Information that could not be included in the online help and important information about
product characteristics.

Instructions not valid for all CPU firmware versions
The firmware version of your CPU determines the following:
● Whether a specific instruction is available for this CPU:
– If you select CPU 1211C DC/DC/DC with firmware version V1.0, for example, the
extended instruction "T_COMBINE" will not be available to you. It is grayed out in the
"Instructions" task card.
– However, if you select CPU 1211C DC/DC/DC with firmware version V3.0, the extended
instruction "T_COMBINE" will be available to you in versions V1.1 and V1.2.
● Which versions of the instruction are available. You can select the different versions in the
"Version" column of the "Instructions" task card.

1.6

Notes on online and diagnostics

Contents
Information that could not be included in the online help and important information about
product characteristics.

Display of interfaces via online access
If the Ethernet interfaces for online access are not displayed sporadically, install hotfix
KB2588507 (for Microsoft Windows) from the Microsoft Support website.
Internet link: http://support.microsoft.com/kb/2588507 (http://support.microsoft.com/kb/
2588507/en-us)
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Notes on the TIA Portal
1.6 Notes on online and diagnostics

Online operation in hibernate mode
We recommend that you do not use the two options "Hibernate" and "Sleep" in online operation;
if you do, communication problems could occur. If necessary, adapt the computer's energy
options.

10
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STEP 7 Professional
2.1

Security information

Upgrades and updates
Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, solutions, machines, equipment and/or networks. They are
important components in a holistic industrial security concept. With this in mind, Siemens’
products and solutions undergo continuous development. Siemens recommends strongly that
you regularly check for product updates.
For the secure operation of Siemens products and solutions, it is necessary to take suitable
preventive action (e.g. cell protection concept) and integrate each component into a holistic,
state-of-the-art industrial security concept. Third-party products that may be in use should also
be considered. For more information about industrial security, visit
http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)
To stay informed about product updates as they occur, sign up for a product-specific
newsletter. For more information, visit
http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
llisapi.dll?aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002)

Network settings
The following tables show the network settings of each product you need to analyze the
network security and to configure external firewalls:
STEP 7 Professional
Name

Port number

Transport
protocol

Direction

Function

Description

ALM

4410*

TCP

Inbound/out‐
bound

License serv‐
ice

This service provides the complete function‐
ality for software licenses and is used by
both the Automation License Manager as
well as all license-related software products.

RFC 1006 102

TCP

Outbound

S7 communi‐
cation

Communication to the S7 controller via
Ethernet/PROFINET for programming and
diagnostic purposes.

DCP

Ethernet

Outbound

PROFINET

The DCP protocol (Discovery and Basic
Configuration Protocol) is used by PROFI‐
NET and provides the basic functionality for
locating and configuring PROFINET devi‐
ces.

---
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STEP 7 Professional
2.2 Notes on use
STEP 7 Professional
SNMP

161

UDP

Outbound

PROFINET

The SNMP client functionality is used by
STEP 7 to read status information from
PROFINET devices.

* Default port that can be changed by user configuration

WinCC ES Basic (without simulation)
Name

Port number

Transport pro‐ Direction
tocol

Function

Description

ALM

4410*

TCP

Inbound/out‐
bound

License serv‐
ice

This service provides the complete function‐
ality for software licenses and is used by
both the Automation License Manager as
well as all license-related software products.

HMI Load

1033

TCP

Outbound

HMI Load (RT
Basic)

This service is used to transmit images and
configuration data to Basic Panels.

* Default port that can be changed by user configuration

Simulation RT Basic
Name

Port number

Transport pro‐ Direction
tocol

Function

Description

HMI Load

1033

TCP

Inbound

HMI Load (RT
Basic)

This service is used to transmit images and
configuration data to Basic Panels.

Ethernet/
IP

44818

TCP

Outbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

2222

UDP

Inbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

Modbus
TCP

502

TCP

Outbound

Modbus TCP
channel

The Modbus TCP protocol is used for con‐
nections to Schneider PLCs.

RFC 1006

102

TCP

Outbound

S7 channel

Communication to the S7 controller via
Ethernet/PROFINET

Mitsubishi
MC

5002

TCP

Outbound

Mitsubishi MC
channel

The Mitsubishi protocol is used for connec‐
tions to Mitsubishi PLCs.

2.2

Notes on use

Content
Information that could not be included in the online help and important information about
product characteristics.

Online operation
The simultaneous online operation of STEP 7 V5.5 or earlier and STEP 7 Professional V13
has not been approved.
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STEP 7 Professional
2.2 Notes on use

Simultaneous online connections on an S7-1200 CPU
It is not possible to establish an online connection from multiple instances of the TIA Portal
simultaneously to the same S7-1200 CPU.

Parallel use
If the term "Combo" appears in the name or license key of the software after installation, the
use of the following products/versions is permitted in accordance with Article 1.6 of the General
Terms and Conditions (see also setup text):
● STEP 7 Professional 2010
● STEP 7 Professional 2006

Documentation on S7-PLCSIM
S7-PLCSIM is installed together with STEP 7 Professional. The documentation is saved
centrally.
You can find the manuals under: C:\Programs\Siemens\Documentation\Product notes
You can find the readme files under: C:\Programs\Siemens\Documentation\Readme

PLC migration
No instruction profile should be activated during PLC migration.
Deactivate your instruction profile before you perform the PLC migration. You can then
reactivate the profile again.

Removing/inserting the memory card
After removing or inserting a memory card, always perform a memory reset on the CPU in
order to restore the CPU to a functional condition.

Deleting data logs on the memory card with S7-1500 CPUs
If you delete data logs (csv files that were generated with data log applications) on the memory
card via the file explorer on the PC, this could result in undefined behavior of the data log
during further operation. The data logs might not be removed completely by the deletion
procedure given above.
Remedy: To delete data logs reliably, use the "DataLogDelete" instruction in the user program
or format the memory card with the help of the online functions in the CPU.
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STEP 7 Professional
2.2 Notes on use

Deleting a WinAC RTX from a SIMATIC PC
A controller application WinAC RTX with an assigned onboard CP interface in an interface slot
(IF) cannot be deleted from a SIMATIC Box PC/Panel PC/Rack PC. If you wish to delete the
WinAC RTX, you must first remove the onboard CP interface from the interface slot. To do
this, the onboard CP interface must be selected in the network or device view and a different
option button (for example, "Windows only" or "SIMATIC PC station") must be activated in the
Inspector window under "CP assignment" instead of the option "SIMATIC WinAC".

Removing and inserting Ethernet modules
If Ethernet modules are removed and re-inserted during operation, you must boot the PC;
otherwise, the "Accessible devices" functionality in STEP 7 or NCM PC will not display all
devices. While the PC boots, Ethernet modules must be activated.

Loading project data with TIA Portal V12 and V13 (S7-1200)
If you load the project data of an S7-1200 CPU with the TIA Portal V13, you can no longer use
TIA Portal V12 to access this data. To do this, first restore the factory settings of the CPU.
Read the additional information on this in the online help under "How to reset a CPU to factory
settings".

Using project data of distributed IO-Link master modules from TIA Portal V12 in V13
The following procedure applies if you are using distributed IO-Link master modules in TIA
Portal V12 that are not GSD devices and were configured with PCT: To continue using your
project data from TIA Portal V12.0 in TIA Portal V13.0, you have to export them to PCT before
you upgrade the project. After the upgrade, you must import the project data once again using
the PCT.

Compatibility
The device configuration and program of an S7-1200 CPU must always be configured with the
same STEP 7 version. Usually, the TIA Portal makes sure that no version conflicts occur by
outputting appropriate notifications during loading to the device.
This automatic verification is not possible with S7-1200 CPUs with firmware version V1.x. In
this case, users themselves must ensure that no version conflicts occur.

See also
TIA-Portal_Link (http://support.automation.siemens.com/WW/view/en/28919804/133000)

14

Readme
Programming and Operating Manual, 12/2014

STEP 7 Professional
2.3 Editing devices and networks

2.3

Editing devices and networks

2.3.1

General information on devices and networks

Content
Information that could not be included in the online help and important information about
product characteristics.

PROFIBUS connection of the I/O to S7-300/S7-400/WinAC
When connecting the distributed I/O of the ET 200MP/SP via PROFIBUS DP to S7-300/S7-400/
WinAC controller, no I&M data and therefore no diagnostics can be displayed.
To work around these restrictions, the two slaves can also be connected using GSD media.

Operation of IM 155-6 DP HF with S7-300/400, ET 200S, ET 200pro or WinAC
The ET 200SP interface module IM 155-6 DP HF with the order number 6ES7
155-6BU00-0CN0 cannot be operated behind an S7-300/400, ET 200S, ET 200pro or WinAC
CPU on PROFIBUS. This configuration cannot be compiled.

Port Configuration Tool PCT
If you use the PCT tool, make sure that you always use the current version that is available
free of charge with the following link:
http://support.automation.siemens.com/WW/view/32469496 (http://
support.automation.siemens.com/WW/view/en/32469496)
The PCT tool is available for installation on the DVD in the "Support" folder.

2.3.2

Use of modules on the S7-1200

Content
Information that could not be included in the online help and important information about
product characteristics.
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STEP 7 Professional
2.3 Editing devices and networks

Use of modules on the S7-1200
The modules listed below are not supported on the S7-1200.
Family

Module

Order number

S7-300 FMs

SM 338

6ES7 338-4BC01-0AB0

FM 350-1

6ES7 350-1AH03-0AE0

FM 350-2

6ES7 350-2AH00-0AE0, 6ES7 350-2AH01-0AE0

FM 351

6ES7 351-1AH01-0AE0, 6ES7 351-1AH02-0AE0

FM 352

6ES7 352-1AH02-0AE0

FM 355 S

6ES7 355-1VH10-0AE0

FM 355 C

6ES7 355-0VH10-0AE0

FM 355-2 C

6ES7 355-2CH00-0AE0

FM 355-2 S

6ES7 355-2SH00-0AE0

CP 340

6ES7 340-1AH02-0AE0, 6ES7 340-1BH02-0AE0, 6ES7
340-1CH02-0AE0

CP 341

6ES7 341-1AH01-0AE0, 6ES7 341-1AH02-0AE0, 6ES7
341-1BH01-0AE0, 6ES7 341-1BH02-0AE0, 6ES7
341-1CH01-0AE0, 6ES7 341-1CH02-0AE0

S7-300 PtP-CP

Network component

Diagnostics repeater 6ES7 972-0AB01-0XA0

ET 200S

1 Count 24 V

6ES7 138-4DA04-0AB0

1 Count 5 V

6ES7 138-4DE02-0AB0

1 Step 5 V

6ES7 138-4DC00-0AB0, 6ES7 138-4DC01-0AB0

2 pulses

6ES7 138-4DD00-0AB0, 6ES7 138-4DD01-0AB0

1 SI

6ES7 138-4DF01-0AB0

1 SI Modbus

6ES7 138-4DF11-0AB0

1 SSI

6ES7 138-4DB02-0AB0, 6ES7 138-4DB03-0AB0

1 Pos Universal

6ES7 138-4DL00-0AB0

SIWAREX

7MH4910-0AA01, 7MH4912-0AA01, 7MH4920-0AA01

SIWAREX

7MH4 900-2AA01, 7MH4 900-3AA01, 7MH4 950-1AA01,
7MH4 950-2AA01

ET 200M

Loading S7-1200 module comments to the PG/PC
In central configurations with S7-1200, comments of modules, submodules and signal boards
are not loaded. With CPs/CMs, only the comments of the IE interface or DP interface are
loaded. In distributed configurations with ET 200SP or ET 200MP, only the comment of the
channels is loaded from the I/O modules.

2.3.3

Replacing ET 200S positioning modules

Contents
Information that could not be included in the online help and important information about
product characteristics.
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STEP 7 Professional
2.3 Editing devices and networks

Replacing ET 200S positioning modules
This information relates to the positioning module "1 Step 5V" (6ES7 138-4DC00-0AB0) from
a project which was created with TIA Portal V11.0. When replacing these modules from the
TIA Portal V11.0 with a new version of these modules, the parameter settings are reset to the
default values.
This is the case with one of the following procedures:
● Replace the positioning module 6ES7 138-4DC00-0AB0 with its successor module 6ES7
138-4DC01-0AB0 by means of a device exchange.
● Updating the module version using the appropriate button in the device properties in the
Inspector window.

2.3.4

CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX

Contents
Information that could not be included in the online help and important information about
product characteristics.

CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX
The module AS-Interface CP 343-2 (article no.: 6GK7 343-2AH01) can be inserted in an
expansion rack of the SIMATIC S7 Embedded Controller EC31-RTX (article no.: 6ES7
677-1DDxx-0BB0), but the CP 343-2 cannot be operated with the EC31-RTX.

2.3.5

F-CM AS-i Safety ST for ET 200SP

Content
Information that could not be included in the online help and important information about
product characteristics.

F-CM AS-i Safety ST (3RK7 136-6SC00-0BC1) from HSP0070
When using an F-CM AS-i Safety ST (3RK7 136-6SC00-0BC1) using HSP0070 in TIA Portal
V13.0, after updating to Service Pack 1, the HSP0070 (F-CM AS-i Safety ST) must be updated
to version V2.0. This is necessary to allow use of the module in TIA Portal V13 Service Pack
1.

Readme
Programming and Operating Manual, 12/2014

17

STEP 7 Professional
2.3 Editing devices and networks

2.3.6

S7 routing via IE/PB Link

Content
Information that could not be included in the online help and important information about
product characteristics.

S7 routing via IE/PB Link
In the following situations, no routing via the IE/PB Link PN IO is possible:
● S7 routing between two CPUs of the S7-1500
● S7 routing of PG connections to CPUs of the S7-1200/1500
● S7 routing of HMI connections to CPUs of the S7-1200/1500
This behavior relates to the IE/PB Link with firmware version V2.1 (6GK1 411-5AB00).

2.3.7

Notes on online and diagnostics

Contents
Information that could not be included in the online help and important information about
product characteristics.

Hardware detection followed by online connection
When the "Online > Hardware detection" command is performed for an unspecified CPU, the
online configuration is not loaded from the CPU. If you do not load the configuration resulting
from the hardware detection to the CPU, the device and network views will always show a
difference between the offline and online configurations. It will appear that there are different
configurations in the online and diagnostic views, although the MLFBs are identical in the actual
CPU and the offline CPU.

2.3.8

Network components

2.3.8.1

S7-1200 telecontrol CPs Load, TeleService, project number, station number

Changing the project number or station number for the entire STEP 7 project
If you change the project number or the station number in the "CP identification" parameter
group for a telecontrol CP, this parameter is changed for all CPs in the STEP 7 project.
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Copying Security modules
Copying stations with activated Security functions to another project without activated Security
functions is forbidden and can lead to serious inconsistencies.

Mobile wireless CPs: Download / TeleService
The following behavior applies to all mobile wireless CPs:
● CP 1242‑7 (6GK7 242‑7KX30‑0XE0)
● CP 1242‑7 GPRS V2 (6GK7 242‑7KX31‑0XE0)
● CP 1243‑7 LTE‑EU (6GK7 243‑7KX30‑0XE0)
● CP 1243‑7 LTE‑USA (6GK7 243‑7SX30‑0XE0)
Connection resources for TeleService
The TeleService function occupies a connection resource on the engineering station.
The function download to device or upload from device during a TeleService session occupies
a second connection resource on the engineering station.
Download to device
Only use the "Download to device" function with the mobile wireless CP via a TeleService
connection as follows:
1. Select the CP in STEP 7.
2. Select the "Online" > "Download to device" menu.
3. In the "Extended download" dialog that appears, select the TeleService interface.
4. Download the project data from the "Extended download" dialog.
Upload from device
The "Upload from device" function via a TeleService connection is supported by the mobile
wireless CPs with the following TeleService server applications:
● TeleControl Server Basic as of version V3
● TeleService Gateway as of version V3

2.3.8.2

S7-1500 CM/CP

CM 1542‑1: Remove retentive storage of the IP address if there are duplicate addresses
The IP address and the device name of the CM 1542-1 remain installed retentively:
If, for example during startup, the CM detects a duplicate address in another network, the CM
is not connected to the network. The CM changes to RUN and cannot be reached via the
Ethernet interface.
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To be able to connect the CM to the network, you can remove the retentively stored IP address
as follows:
1. Remove the memory card of the CPU.
2. Using DCP with the Primary Setup Tool (PST) and with the CPU in STOP, set the IP address
of the CM to 0.0.0.0 without configuration.
You have removed the retentively stored IP address of the CM. The CM can be connected
into the network.
3. Insert the memory card in the CPU again.

2.3.8.3

PC CPs and applications

PC CPs for VMware vSphere Hypervisor ESXi
The following communications processors have been released for operation with VMware
vSphere Hypervisor ESXi:
● CP 5711
● VMware E1000 network adapter
The following communications processors have not been released for operation with VMware
vSphere Hypervisor ESXi:
● CP 5611
● CP 5612
● CP 5621
● CP 5622
● CP 5512
Other communications processors such as the CP 1623 and CP 1628 are released following
installation of the SIMATIC NET PC software. You will find information on this in the readme
file of the SIMATIC NET PC software.

Downloading to PC stations with a CP 1628
If you download project data to a CP 1628, make sure that the CP is reachable.
In the "Extended download to device" dialog, do not enable the check box for the search for
compatible nodes.
If you want to download to a different CP from the one selected earlier in the project, change
the IP address of the CP manually in the "Extended download to device" dialog in the list of
configured access nodes.

PROFIBUS S7 connections with OPC servers
The configuration of an S7 connection via PROFIBUS is not possible between an OPC server
as of V12 and an S7‑1200 as of V4 or an S7‑1500.
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Remedy: Use an OPC server / PC application < V12 or use an S7‑1200 < V4 or an S7‑300 or
S7‑400 as the S7 station.

2.3.8.4

Security modules

Migration of projects with Ethernet CPs and activated security functions
In STEP 7 V5.5 projects that contain Industrial Ethernet CPs with activated security functions,
the security settings are disabled during migration to STEP 7 Professional.
If necessary, follow these steps after the migration:
1. Activate the security functionality.
2. Configure the required security settings.

Migration of IP access protection lists when activating the security functions
An active IP access protection list is converted to firewall rules when security functions are
activated. These rules are visible in advanced firewall mode and can be adjusted there. The
advanced firewall mode is activated automatically.

Copying Security modules
Copying stations with activated Security functions to another project without activated Security
functions is forbidden and can lead to serious inconsistencies.

Security online diagnostics of S7 CPs
Security online diagnostics of a CP with security capability is only possible if the online
connection is established directly via the CP. If the online connection was established by
STEP 7 via the CPU to the station, with the "Connect online" button on the security diagnostics
page "Security" > "Status" of the security CP you can establish a direct connection to the CP
to run security online diagnostics. As an alternative, you can also terminate the online
connection to the CPU and enter the IP address of the CP in the "Station address" input box
under the entry "Online access" in online diagnostics.

IKE mode
When negotiating the key in phase 1 the IKE mode "Main" should be preferred. This mode
normally provides a reliable procedure compared with the "Aggressive" mode. One reason for
using the "Aggressive" setting is when you have VPN groups with different pre-shared keys
since only one pre-shared key is supported with the "Main" setting.
The IKE "Aggressive" mode should not be used in conjunction with certificates. In the IKE
"Aggressive" mode, only use pre-shared keys.
The SOFTNET Security Client only supports the IKE "Main" mode.
A security module must not be used in VPN groups that use different IKE modes.
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Downloading configuration data to an S7-300/400 via a VPN tunnel
When you download configuration data via the gigabit interface of a CP x43-1 Advanced to an
S7-300/S7-400 station, the path via which the download takes place is stored in the project.
If the project is then downloaded via a VPN tunnel established between a SCALANCE S
module and the CP x43-1 Advanced, the download fails due to the changed path.
To download via the VPN tunnel, follow the steps below:
1. Using the "Go online" button, connect the engineering station to the gigabit interface of the
CP x43‑1 Advanced.
2. Disconnect the online connection to the CP x43‑1 Advanced.
3. Download the project to the station via the gigabit interface of the CP x43‑1 Advanced.

VPN tunnel establishment with 1200/1500 CPs capable of VPN
The establishment of VPN tunnel connections by 1200/1500 CPs capable of VPN with the
authentication method "pre-shared key" is only possible if the VPN connection partner is also
a 1200/1500 CP capable of VPN. The establishment of VPN tunnel connections by a
1200/1500 CP capable of VPN to all other VPN connection partners is only possible with the
"certificate" authentication method.

2.3.8.5

Media converters
When you migrate a project, you need to reconfigure the media converters.

2.4

Programming a PLC

2.4.1

General notes on PLC programming

Content
Information that could not be included in the online help and important information about
product characteristics.

Information about network security
For communications access between the TIA Portal and CPU or between HMI (except for HMI
access using "GET/PUT communication") and CPU, there are integrated security functions.
These provide greater protection from manipulation and higher access protection. To protect
against unauthorized network access to a CPU with standardized communications access
such as "GET/PUT", "TSEND/TRCV", "Modbus", "FETCH/WRITE", you should also take
suitable additional measures (e.g. cell protection concept).
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Renumbering PLC data types
For better performance, the S7 CPUs process PLC data types with numbers. The user is not
aware of these numbers, because the system processes the numbers independently. This
means number conflicts are automatically resolved. When using know-how protected blocks
that use PLC data types, it may be useful to set up your own numbering system (recommended
> 5000) because the automatic resolution of numbering conflicts may result in a password
prompt (compilation required).
To renumber the default number of a PLC data type, follow these steps:
1. Open the project library in the "Libraries" task card.
2. Drag the compilable PLC data type to the "Types" folder.
The "Add type" dialog opens.
3. Enter the properties of the new type.
4. Click "OK" to confirm.
5. Right-click the PLC data type.
The shortcut menu opens.
6. Select "Edit type" in the shortcut menu.
7. Open the "PLC programming" task card once again.
The extension "in testing" is now added to the name of the PLC data type.
8. Right-click the PLC data type.
The shortcut menu opens.
9. Select "Properties" in the shortcut menu.
10.Change the number of the PLC data type in the "General" section.
11.Select "Release version" from the shortcut menu of the library.
The PLC data type now has the new number and can be used. The assigned number is retained
even if the type of the PLC data type is revoked.

Generating external sources from blocks
When generating external sources from blocks, the changes made directly in the block
interface to the default values of PLC data types are not exported to the sources. This means
these values are not available when the sources are imported once again. The default values
are applied instead. To prevent this loss of data for the modified default values, the changes
must be made directly in the PLC data type and not in the block interface. In this case, the
changes are also exported when generating external sources.

Indirect indexing of ARRAY components of data type bit string in SCL
In TIA Portal V13, you can address the components of an ARRAY for a CPU of the
S7-1200/1500 series in SCL with a tag of the data type BYTE, WORD, DWORD or LWORD
as index in addition to a tag of the integer data type if the IEC check is not set. This is not
possible for a CPU of the S7-300/400 series.
The result is an incompatibility with TIA Portal V12 SP1 in which indirect indexing with the data
type bit string is also permitted on a CPU of the S7-300/400 series.
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Declaring internal parameters of a GRAPH block as retentive (S7-1500 < V1.5)
When you declare the internal parameters of a GRAPH block as retentive, the sequence control
remains in the current status and continues from the point at which it was interrupted after a
change to "RUN". Please note that supervisions should not be used if you activate the new
parameter "Retentive internal parameters" in a GRAPH block.

Explicit data type conversion in SCL (S7-1200/1500)
As of TIA Portal V13, the string is displayed with a leading sign during explicit data type
conversion of SINT/INT/DINT/LINT_TO_STRING or WSTRING in SCL and transferred aligned
to the left.
The result is an incompatibility with TIA Portal V12 SP1, in which the string was transferred
aligned to the right during conversion.

Functions from the global library "Long Functions" with PLCSIM S7-1500
The compilation process links the functions of the S7-1500 CPU family to the CPU to protect
them from manipulation. Function from the global library "Long Functions" that are used in the
CPU and have such a link cannot be loaded to a simulation. However, it is possible to replace
such elements with their originals from the global library. These are not linked to a CPU.

Loading inconsistent programs to an S7-1500 CPU
In TIA Portal, it is not possible to download inconsistent programs to an S7-1500 CPU without
a consistency check. During the loading process, all blocks of the program are implicitly
checked and are compiled again in the event of inconsistencies. If, however, there are
programs on your CPU which were loaded with earlier versions of STEP 7, these programs
could demonstrate inconsistencies.
In this case, note the following:
If you load an inconsistent program from a device, you will not be able to load the program
back to an S7-1500 CPU unchanged afterwards, because a consistency check always takes
place during the loading process and existing inconsistencies are corrected.

24

Readme
Programming and Operating Manual, 12/2014

STEP 7 Professional
2.4 Programming a PLC

Loading data blocks from a device
Please note that the two CPU families handle the values of tags differently when downloading
blocks from a device:
● S7-1200/1500
CPUs of the S7-1200 series store the start values with which a data block is loaded to the
CPU in the load memory. If you load a data block from an S7-1200 CPU, these start values
are applied from the load memory to the offline data block again. Even if you have made
value changes in the load memory during runtime by means of the "WRIT_DBL" instruction,
the values originally loaded to the device are applied to the offline data block.
In order to apply the current monitored values from the CPU, you can use the function
"Snapshot of the monitored values". You can find detailed information on this in the
information system, in the section "Programming data blocks".
● S7-300/400
CPUs of the series S7-300/400 also store the start values with which a data block is loaded
to the CPU in the load memory. However, they cannot read the values back from the load
memory. If you load a data block from a device, the current monitored values are loaded
from the CPU and entered in the "Start values" column in the offline data block.

Start value behavior during "Upload from device" (S7-1500)
The start values that you have changed with the instruction "WRIT_DBL: Write to data block
in the load memory" will be lost during execution of the action "Upload from device".

Online/offline differences in the project tree (S7-1200 FW V2.0 and V2.1)
If you use the instruction "WRIT_DBL: Write to data block in the load memory" to change a
data block, the resulting difference between online and offline block is initially not displayed
correctly by the symbols in the project tree. The difference is only shown when you terminate
an online connection and then go back online.

Importing organization blocks from external STL/SCL sources
CPUs of the S7-300/400 series accept organization blocks with any name during import. If you
import an OB with a standard name (for example, CYCL_EXC or CYC_INT5), the correct OB
class is automatically assigned. If you import an OB with an unknown name, an OB0 is created.
You can change this number after the import and hereby assign it to the desired OB class. To
change to the OB number, select "Properties" in the shortcut menu.
When importing from external sources to a CPU of the series S7-1200/1500, only organization
blocks with standard names are accepted. An OB with an unknown name is invalid after the
import and is identified with a no parking character. You should, therefore, use a text editor to
change the name of the organization block in the title bar of the external source before the
import into the TIA Portal.
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Process image of PTO/PWM outputs
Do not use PTO/PWM outputs in the process image (for example, for access in the user
program, for online functions or in HMI). The update rate of the process image is much slower
than the rate of the signal changes. The display in the process image therefore does not reflect
the signal flow.

Moving system blocks
Moving objects from the "System blocks" folder to the "Program blocks" folder is not permitted.

Monitoring blocks in LAD and FBD
If the start of the current path is outside the visible range, it may not be possible to determine
the input value. In this case, the current path is shown grayed out.

Resetting registration requirements for GRAPH blocks
When errors and faults are reset via the "REG_EF" input parameter, the following differences
exist between the CPU families with respect to resetting the registration requirement:
● S7-300/400
The registration requirement is retained until an interlock or supervision error occurs in a
step. Only then is the "R1" event triggered, the associated action executed, and the
registration requirement reset.
● S7-1500
The registration requirement is always reset, regardless of whether interlock or supervision
errors occur in the current cycle.

Avoid using PLC data types generated by the system in libraries
Some instructions generate their own PLC data types during instancing which are saved in
the "PLC data types" project folder. However, you should not use these system-generated
PLC data types in any library, because they may be recreated by the system at any time and
may result in an unfavorable system behavior.

Note on data consistency in S7 communication and Open User Communication
In the S7-1500 module series, you can change parameters during ongoing operation with the
instructions of S7 communication as well as with Open User Communication. Changed
parameters are used immediately, even if a job is still active. Both can lead to data
inconsistency! To avoid data inconsistencies, you should never change parameters while a
job is running.

Using global data blocks in assignments
It is not possible to assign the contents of a global data block to a structurally identical data
block, e.g. using a move box.
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2.4.2

Compatibility of PLC programs from V12 SP1 or V13

Content
Information that could not be included in the online help and important information about
product characteristics.

Compatibility
You can continue to use in V13 SP1 all programs that were created with TIA Portal V12 SP1
or V13. However, because improvements were made to the compiler and errors corrected
there (compilation of the program code) in V13 SP1, it can occur in rare cases that the program
reacts differently after the upgrade or that you have to adjust the program code manually.
These cases are described in detail below.
In addition, you have the option of editing the project in compatibility mode. Compatibility mode
is available for projects that were created with TIA Portal V12 SP1 and V13.
You can find additional information on the compatibility under "Compatibility of projects".

Instruction "S_CONV: Convert character string"
Der EN/ENO mechanism behaves differently in TIA Portal V13 SP1 than in TIA Portal V13.
In version V13, the ENO enable output returns the signal state "0" in case of error, even if you
have deactivated the ENO enable output. If you have switched an additional instruction to the
ENO enable output, this is then not executed.
In version V13 SP1, the ENO enable output returns the signal state "1" in case of error, if you
have deactivated the ENO enable output. If you have switched an additional instruction to the
ENO enable output, this is then executed as expected.

Instruction "SET: Set bit array"
In the TIA Portal, you can also interconnect an element of a data block at the N parameter of
the SET instruction.

Instruction "MUX: Multiplex" (SCL)
Up to and including TIA Portal V13, the value of the tag at the input parameter was output
unchanged as a function value, even if the K parameter had a negative integer. This behavior
has changed in TIA Portal V13 SP1.
In TIA Portal V13 SP1, if you use the BOOL, STRING, DT or DTL data types at the input
parameters of the MUX instruction and the K parameter is a negative integer, the value of the
tag is changed.
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Instruction "DEMUX: Demultiplex" (SCL)
Up to and including TIA Portal V13, no value was output at the OUTELSE output parameter if
the value of the K parameter was < 0. In contrast, the value of the IN input parameter was
output at the OUTELSE output parameter if the value of the K parameter was > available
outputs. This behavior has changed in TIA Portal V13 SP1.
In the TIA Portal V13 SP1, if you specify at the K parameter a value that is outside the available
outputs (K < 0 or K > available outputs), then the value of the IN input parameter is output at
the OUTELSE output parameter.

Instruction "MOVE: Move value" (STL) (S7-1500)
As of the TIA Portal V13 SP1, a stricter syntax rule applies to the "MOVE" instruction in STL:
Up to and including TIA Portal V13. it was possible to specify non-typed constants, such as
"0" at the input parameter IN.
If you want to copy, for example, the value "0" in the TIA Portal V13 SP1, you need to specify
a typed constant according to the data type of the output parameter (e.g. INT#0, DINT#0, etc.).

Function values (Return)
As of TIA Portal V13 SP1, more stringent syntax rules apply to function call:
It is checked that the function value (Return) is written in any case, even if multiple possible
program paths can be run through in the function. Therefore, there is no longer any risk that
the function values will accidentally not be written during runtime.
However, you may possibly receive syntax errors in functions during compiling, which it was
still possible to compile without errors in V13. In such cases change the program code so that
the function valve is written in all possible program paths.
Example:
SCL
IF #MyIn1 = #MyIn2 THEN
#Block_3 := #MyIn1 + 1;
END_IF;

In this example, the function value of "Block_3" is not written if the condition of the IF instruction
is not fulfilled. The function value then contains an undefined value.
SCL
#Block_3 := #MyIn1;
IF #MyIn1 = #MyIn2 THEN
#Block_3 := #MyIn1 + 1;
END_IF;

In this example the function valve of "Block_3" is definitely written in the program, since "MyIn1"
is set as default before the IF loop is completed.
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Comparing the hardware data types HW_IO and HW_DEVICE
As of TIA Portal V13 SP1, there is a stricter syntax rule that is valid for the comparison of the
data types HW_IO and HW_DEVICE:
Up until and including TIA Portal V13 it was possible to compare the data types HW_IO and
HW_DEVICE directly with each other.
If you want to compare these data types in TIA Portal V13 SP1 you have to first create a tag
of the data type HW_ANY in the section "Temp" for the block interface and then copy the
LADDR (from data type HW_DEVICE) to the tag. It is then possible to compare HW_ANY and
HW_IO.

Implicit conversion of floating-point numbers to DWORD (GRAPH) (S7-1500)
As of TIA Portal V13 SP1 stricter syntax rules apply for the implicit conversion of floating-point
numbers to DWORD:
Up to and including TIA Portal V13, it was possible to convert a non-typed constant (e.g. 1.0)
implicitly to the data type DWORD if the value was less than 32 bits.
With TIA Portal V13 SP1, if you want to convert a floating-point number implicitly to the data
type DWORD, you can only use typed constants (e.g. REAL#1.0) since a non-typed constant
(e.g. 1.0) is interpreted as data type LREAL and can no longer be converted implicitly to
DWORD.

Assigning a value to a LTIME constant
As of the TIA Portal V13 SP1, a stricter syntax rule applies to the definition of a value to a
LTIME constant:
Up until and including TIA Portal V13 it was possible to assign a TIME value (e.g. T#10s) to a
LTIME constant.
If you want to assign a value to a LTIME constant in TIA Portal V13 SP1, you have to use
LTIME syntax. (e.g. :LT#10s).
Please note that the corresponding TIA Portal projects from previous versions already had to
have been adjusted before the upgrade to TIA Portal V13 SP1.
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EN/ENO mechanism for STRING conversion
Conversion

Description

Strg_TO_Chars: Convert character string to Array
of CHAR

The ENO enable output returns the signal state "0"
even if you have deactivated the ENO enable out‐
put:
● For an invalid character at the CHARS
parameter
● For an invalid ARRAY index at the PCHARS
parameter
● If the sum of the PCHARS and STRG
parameters exceeds the length of the target
ARRAY.

Chars_TO_Strg: Convert Array of CHAR to char‐
acter string

The ENO enable output returns the signal state "0"
even if you have deactivated the ENO enable out‐
put:
● If the sum of the PCHARS and CNT
parameters exceeds the length of the source
ARRAY.

Overflow of the local data stack (S7-300/S7-400)
As of TIA Portal V13 SP1, the size of the local data stack is checked to ensure it does not
exceed what you have defined for the OB priorities in the hardware configuration.
This means that you may get error messages during compilation in projects that could be
compiled without errors in V13. If this happens, change the maximum size of the local data
stack in the hardware configuration.

2.4.3

Instructions

Content
Information that could not be included in the online help and important information about
product characteristics.

Instruction "PE_WOL: Starting and stopping energy-saving mode via WakeOnLan" (S7-1500)
This instruction only supports devices with a device number lower than 256. Devices with a
higher device number are ignored.
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Instruction "DataLogCreate: Create data log"
In addition to the values described in the online help, the RET_VAL parameter can also adopt
the following values:
Error code
(W#16#...)

Explanation

8B24

Invalid assignment at parameter HEADER (for example, bit memory used as memory
area).

8C24

Invalid assignment at parameter DATA (for example, bit memory used as memory area).

Instruction "DPSYC_Fr: Synchronize DP slaves / Freeze inputs"
In addition to the values described in the online help, the RET_VAL parameter can also have
the following value:
Error code
(W#16#...)

Explanation

80A4

Communication on central PROFIBUS disrupted.

Instruction "Get_IM_Data: Reading identification and maintenance data"
The explanation for the values of the RET_VAL parameter described in the online help has
been changed as follows:
Error code
(W#16#...)

Explanation

80B1

No valid data available. (The I&M data is either not supported by the (sub)module or you
have not configured I&M data for this device.)

Instruction "T_RESET: Resetting the connection"
In addition to the values described in the online help, the STATUS parameter can also have
the following value:
Error code
(W#16#...)

Explanation

7000

No job processing active.

Instruction "TCON: Establish communication connection"
In addition to the values described in the online help, the STATUS parameter can also have
the following value:
Error code
(W#16#...)

Explanation

80A1

The specified connection or the port is already being used.
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Instruction "GADR_LGC: Determine hardware identifier from slot and offset in the user data address
area"
The "GADR_LGC" instruction always outputs the hardware identifier even in the exceptional
case of the ET200 with packed addresses described in the documentation.

Instruction "RD_ADDR: Determine the IO addresses from the hardware identifier"
Output of the IO addresses with packed addresses of an ET200
With packed addresses of an ET200. the first module of the pack group returns all addresses.
For the other modules, the following is output with the PIADDR and PQADDR parameters:
● With PROFINET as address "0".
● With PROFIBUS as address "0". The error code 16#8090 (the hardware identifier of the
module at the LADDR parameter is invalid.) is also output.
For the number of bytes of the inputs and outputs (parameters PICOUNT and PQCOUNT),
"0" is output in each case.

Instruction "RD_LGADR: Determine the IO addresses from the hardware identifier"
Output of the IO addresses with packed addresses of an ET200
With packed addresses of an ET200. the first module of the pack group returns all addresses.
For the other modules, the following is output with the PEADDR and PAADDR parameters:
● With PROFINET as address "0".
● With PROFIBUS as address "0". The error code 16#8090 (the hardware identifier of the
module at the LADDR parameter is invalid.) is also output.
For the number of bytes of the inputs and outputs (parameters PECOUNT and PACOUNT),
"0" is output in each case.

Passing parameters to asynchronous executable blocks
Code blocks (FBs/FCs) and data blocks (DBs) can be created with different access types
("standard" and "optimized"). In code blocks, you can call any instructions. Many instructions
(e.g. "WRIT_DBL" and "READ_DBL") are executed asynchronously. These blocks cannot be
supplied with tags from TEMP because the data must not be changed during execution.
Ensure that you do not use these instructions in programs in which code blocks of different
access types are called reciprocally. This could cause the following to occur:
● A structure from a standard data block is directly or indirectly passed to an optimized code
block, which forwards this structure directly or indirectly to one of the blocks mentioned
above.
● The reverse scenario, whereby a structure from an optimized code block is directly or
indirectly passed to a standard data block, which forwards this structure directly or indirectly
to one of the blocks mentioned above.
Otherwise a hidden copy of the passed data is created in TEMP, which leads to the
asynchronous blocks returning a negative acknowledgment.
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Notes on the use of "RecipeExport" and "RecipeImport"
● The instructions RecipeExport and RecipeImport are not suitable for applications in which
special protection is necessary for the recipe data. For higher protection of the data use
the recipe functions of HMI.
● The data block with the recipe data exported with RecipeExport can be located in work or
load memory. If the data block is both in work memory as well as in load memory, the values
from work memory are used.
● You can use different separators for the separators of the row values in the recipe. Note
that if you open the CSV file with the exported recipe data, for example in Excel, commas
can be replaced by periods and vice versa. The reason for this is that different languages
use different decimal separators. This can have effect when importing CSV files. The
following convention applies for RecipeImport; the first detected possible separator is
assumed to be the separator for all values of a table row.
– Example 1: If a semicolon is detected as the first separator, during import it is assumed
that the semicolon is used as the separator for all further values. As the decimal
separator with a value of the type REAL, a comma is then used.
– Example 2: If a comma is detected as the first separator, during import it is assumed
that the comma is used as the separator for all further values. As the decimal separator
with a value of the type REAL, a period is then used.
If the recipe data record contains a character string, make use that the character string
does not contain the separator you are using. With character strings, also make sure that
they do not contain any control characters that specify a line break (with ASCII: LF, CR LF,
CR).
Note: Spaces and tabs cannot be used as separators. The lead to error code 80B2 during
import.

Notes on the use of data logs
Data logs are stored as a CSV file and can be opened using the Web server, for example in
Excel. If you use character strings within a data log, make sure that you do not use any
characters in the character strings that are also used as the separator for the row elements of
the CSV file.

Instructions STRG_VAL and VAL_STRG
The instructions STRG_VAL and VAL_STRG are also available in the SCL programming
language in V13 SP1 in contrast to the restriction in the online help.

Instruction "SHUT_DOWN: Shutdown target system"
Description:
You can use the "Shutdown target system" instruction to shut down the PC-based automation
system and start the S7 software controller CPU 150xS or Windows on the PC-based
automation system.
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This is practical in the following situations, for example:
● An industrial UPS (uninterruptible power supply) reports power failure via a digital input.
● Windows stops responding or shows a "Blue Screen".
● Too many error OBs are called in the user program.
Parameters:
The following table shows the parameters of the "Shut down PLC" instruction:
Parameters

Declaration

Data type

Memory area

MODE

Input

UINT

I, Q, M, D, L or con‐ MODE = 1: Shut down CPU
stant
150xS and Windows
The CPU goes to STOP and
saves the retentive data.
Then the CPU and Windows
are shut down. The system
must be restarted manually.

Description

MODE = 2: Restart CPU
150xS
The CPU goes to STOP and
saves the retentive data.
Then the CPU is shut down
and restarted.
MODE = 3: Restart Windows
The CPU remains in RUN.
Windows is restarted.
COMMENT

Input

STRING

I, Q, M, D, L or con‐ With MODE = 1 and MODE
stant
= 3, you can specify a reason
for the restart. The reason is
output in the Windows Event
Log.

RET_VAL

Return

WORD

Q, M, D, L

Ret_Val = 0: No error
Ret_Val = 8090: The value
passed to MODE is not sup‐
ported.
Ret_Val = 80xy: Windows
does not respond to the call
of the instruction.

Output parameters of the S7-1500 instructions
If an access error or a programming error occurs while the instruction is being executed, the
value of the output is undefined.
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2.4.4

Testing the user program

2.4.4.1

Testing with the watch table

Content
Information that could not be included in the online help and important information about
product characteristics.

Multiple access to the same CPU (S7-300/400/1200)
Online access to a CPU (S7-300/400/1200) from a PG/PC is permitted only when a TIA Portal
is open. Multiple access to the same CPU of this family is not permitted and can lead to errors.

Loading data blocks during an active control job
Note
Loading changed data blocks during an active control job can result in unforeseen operating
states. The control job continues to control the specified address, although the address
assignment may have changed in the data block. Complete active control jobs before loading
data blocks.

"Enable peripheral outputs" function
The function "Enable peripheral outputs" in not available for CPUs of the S7-1500 series in
the TIA Portal V13.
This function can only be executed with an S7-300, S7-400 or S7-1200 CPU in TIA Portal V13.

Testing programs converted from older STEP 7 versions
To monitor and test a program converted from an older STEP 7 version, you first need to
compile and download the program with the current STEP 7 version.

2.4.4.2

Testing with the force table

Content
Information that could not be included in the online help and important information about
product characteristics.
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Forcing tags for direct I/O access
If you use direct I/O access for an S7-300 CPU in your user program, forcing this I/O address
is not permitted.

Example
If I/O access to the address "IB0:P" takes place in the user program, it is not permitted to force
the following I/O address areas: I0.0:P, IB0:P, IW0:P and ID0:P.

2.5

Inter Project Engineering (IPE)

2.5.1

Notes on IPE

Content
Information that could not be included in the online help and important information about
product characteristics.

Comment box of the device proxy
Contrary to the description in the information system for the TIA Portal V13, with the "Inter
Project Engineering" functionality, the comment field for a device proxy cannot be edited.

Restricted functionality
In the TIA-Portal V13, the "S7 GRAPH overview" and "PLC code display" functionality cannot
be used in conjunction with the IPE device proxy.

Using system diagnostics in the device proxy
To use the "system diagnostics" function in an IPE device proxy, for example, a system
diagnostics view, insert the PLC alarms as content of a device proxy.

Connections to the SIMATIC S7-1500 software controller
Connections to the SIMATIC S7-1500 software controller as device proxy are only possible
via the interfaces assigned to the software PLC.

Support of Alarm_S alarms
The integrated configuration with WinCC and SIMATIC Manager support the Alarm_S alarms,
which are available via data blocks and Continuous Function Chart (CFC).
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2.6

Technological functions

2.6.1

Notes on technological functions

S7-1500 technology modules
Contrary to the information provided in the online help, the commissioning editor for the
S7-1500 technology modules is not yet available.

S7-1500 Motion Control - Configuration of a positioning axis via an HMI device
If a tag exists both at the speed axis and at the positioning axis (e.g. <TO>.Velocity), you
cannot access the tag of the positioning axis via an HMI device.
Copy the tag of the positioning axis via your user program into a data block which you have
created. You can access the copy of the tag via an HMI device.

S7-1500 Motion Control - FAQs with remedies for technology alarms
You can find the FAQs with remedies for technology alarms on the Internet (http://
support.automation.siemens.com/WW/view/en/66958052).

S7-1500 Motion Control - tuning
After a test step for tuning is started, the axis is slowed down with the configured maximum
delay after the measuring duration has elapsed.

S7-1500 Motion Control - Changing the configuration offline
If you change the configuration of the axis offline and download the CPU in RUN operating
mode, the modified parameters are displayed, but only take effect after the technology object
has been restarted.
To do this, call MC_Reset with Restart = TRUE.

S7-1500 Motion Control and S7-1200 Motion Control
S7-1200 Motion Control and S7-1500 Motion Control are different. The operating modes of
the motion control instruction MC_Home are not compatible.
You have to modify your user program. Programs which are transferred to another CPU series
always have to be recommissioned.

S_USSI on S7‑1500
Note the following when using the instruction S_USSI of the distributed I/O ET 200S 1SI on
an S7‑1500.
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The parameter ANZ shows the value 0 even in the case of an error.
If the CPU is switched to stop with the S_USSI instruction, check all possible errors listed at
the parameter ANZ.

PtP module with CM 1243-5 PROFIBUS Master
You have to make the following settings in the instance DB for the instructions when using the
PtP-Module CM PtP RS232 BA, CM PtP RS422/485 BA, CM PtP RS232 HF, CM PtP
RS422/485 HF and CM PtP with a CM 1243-5 PROFIBUS Master with firmware ≤ V1.3.4:
● Send_P2P
max_record_len = 240
● Modbus_Master
Send_P2P.max_record_len = 240
● Modbus_Slave
Send_P2P.max_record_len = 240

PID_Temp on CPU 1500 V1.7
Note the following when using PID_Temp on a CPU 1500 with firmware version V1.7:
● The integrated dead zone in PID_Temp must not be used on CPU 1500 V1.7.
Do not change the preset 0.0 of the associated parameters
Retain.CtrlParams.Heat.DeadZone and Retain.CtrlParams.Cool.DeadZone.
● If the cooling output is active (PidOutputSum < 0.0, OutputCool <> 0.0) for a closed loop
controller with active cooling and PID parameter switchover (Config.ActivateCooling =
TRUE, Config.AdvancedCooling = TRUE) while "Pretuning cooling" is started (Mode = 1,
Heat.EnableTuning = FALSE, Cool.EnableTuning = TRUE), aborts with error ErrorBits =
16#0040_0000.
– In this case use "Fine tuning cooling" (Mode = 2, Heat.EnableTuning = FALSE,
Cool.EnableTuning = TRUE)
or
– Before starting the pretuning, switch to manual mode with a manual value larger than
0.0 (Mode = 4, ManualValue ≥ 0.0).
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2.6.2

Notes on technological functions

S7-1200 Motion Control - MC_Home
The motion control instruction "MC_Home" has been extended with the absolute value encoder
adjustment:
● Absolute encoder adjustment (relative)
MC_Home.Mode = 6
The current position is shifted by the value of the parameter "MC_Home.Position".
The calculated absolute value offset is stored retentively in the CPU.
(<Axis name>.StatusSensor.AbsEncoderOffset)
● Absolute encoder adjustment (absolute)
MC_Home.Mode = 7
The current position is set to the value of the parameter "MC_Home.Position".
The calculated absolute value offset is stored retentively in the CPU.
(<Axis name>.StatusSensor.AbsEncoderOffset)

S7-1200 Motion Control - MC_WriteParam
Motion control instruction "MC_WriteParam" for drive connection via PROFIdrive/analog
output:
Contrary to the statements in the online help, you cannot write parameters with
"MC_WriteParam" which require a restart of the technology object.

S7-1200 Motion Control - MC_ChangeDynamic
You can only use the motion control instruction "MC_ChangeDynamic" for drive connection
via PTO (Pulse Train Output).

S7-1200 Motion Control - Application cycle MC-Servo [OB91]
To avoid disruptions in the program execution on the CPU, set the application cycle depending
on the number of used axes as follows:
Application cycle = number of axes x 2 ms
Number of axes

Application cycle

1

2 ms

2

4 ms

4

8 ms

8

16 ms

The SINAMICS G120 drive updates the drive process image every 4 ms. To improve control,
set the application cycle of the MC-Servo [OB91] to 4 ms or to a multiple of 4 ms.

S7-1200 Motion Control - Overflow MC-Servo [OB91]
Contrary to the online help, the CPU does not go into STOP at overflow of the MC-Servo [OB91].
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If necessary, you can set the CPU to STOP at overflow of MC-Servo [OB91] via a time-error
OB (OB80).

S7-1200 Motion Control - Process image partition "OB Servo PIP"
For optimal control of all I/O modules (e.g. hardware limit switches) used by Motion Control,
assign them to the process image partition "OB Servo PIP". The assignment causes the I/O
modules to be processed simultaneously with the technology object.
A high-speed counter (HSC) used by Motion Control is automatically assigned to the process
image partition "OB Servo PIP".

S7-1200 Motion Control - Renaming technology objects
In order to assure the consistency of your project, after you rename the technology objects,
download the project to the CPU while it is in STOP. A name change includes when you delete
a technology object and create a new technology object with a new name and data block
number of the deleted technology object.

S7-1200 Motion Control - ErrorIDs and ErrorInfos
The ErrorInfo 16#003D is also displayed if a drive with an analog drive connection has turned
off.
The ErrorInfo 16#002C has been supplemented for the ErrorID 16#820A:
ErrorID

ErrorInfo

Description

16#820A

Solution

It is not possible to restart the axis
16#0013

The axis is enabled in the user program

Disable the axis with the "MC_Power" instruction;
restart again

16#0027

The axis is currently being operated in "Manual
control" (axis control panel)

Exit "Manual control"; restart again

16#002C

The axis is not disabled.

Disable the axis; restart the command

16#0047

The technology object is not ready for restart.

Download the project again.

16#0048

Condition for restart of the technology object is
not satisfied.

Disable the technology object.

PtP module with CM 1243-5 PROFIBUS Master
You have to make the following settings in the instance DB for the instructions when using the
PtP-Module CM PtP RS232 BA, CM PtP RS422/485 BA, CM PtP RS232 HF, CM PtP
RS422/485 HF and CM PtP with a CM 1243-5 PROFIBUS Master with firmware ≤ V1.3.4:
● Send_P2P
max_record_len = 240
● Modbus_Master
Send_P2P.max_record_len = 240
● Modbus_Slave
Send_P2P.max_record_len = 240
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2.6.3

Notes on technological functions

Parameter assignment for the FM x51 and FM x52
In contrast to the information in the Online Help, if you change the measuring system, the
previously entered parameter values are not converted to the new measuring system.

Programming FM x50-1, FM x51 and FM x52
The "initial values" specified in the parameter tables in the online help regarding the instructions
correspond to the "default value" in the software interface of the user programming.

IM 174 migration
During the migration of projects with IM 174, the parameter assignment of IM 174 is set to
default values. It is absolutely necessary to set parameters for IM 174 again after the migration.

2.6.4

SIMATIC STEP 7 Easy Motion Control

2.6.4.1

Notes on SIMATIC STEP 7 Easy Motion Control
There are no notes available on SIMATIC STEP 7 Easy Motion Control.

2.6.5

SIMATIC STEP 7 PID Professional

2.6.5.1

Notes on SIMATIC STEP 7 PID Professional
There are no notes available on SIMATIC STEP 7 PID Professional.
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Security information
Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, solutions, machines, equipment and/or networks. They are
important components in a holistic industrial security concept. With this in mind, Siemens’
products and solutions undergo continuous development. Siemens recommends strongly that
you regularly check for product updates.
For the secure operation of Siemens products and solutions, it is necessary to take suitable
preventive action (e.g. cell protection concept) and integrate each component into a holistic,
state-of-the-art industrial security concept. Any third-party products that may be in use must
also be taken into account. For more information about industrial security, visit
http://www.siemens.com/industrialsecurity (http://support.automation.siemens.com)
To stay informed about product updates as they occur, sign up for a product-specific
newsletter. For more information, visit
http://support.automation.siemens.com (http://support.automation.siemens.com)

Passwords
Various passwords are set by default in WinCC. For security reasons, you should change
these passwords.
● For the user "Administrator", the default password is "administrator".

Communication via Ethernet
In Ethernet-based communication, end users themselves are responsible for the security of
their data network. The proper functioning of the device cannot be guaranteed in all
circumstances; targeted attacks, for example, can lead to overload of the device.

Ending Runtime automatically
If automatic transfer is enabled on the HMI device and a transfer is started on the configuration
PC, the running project is automatically stopped on the HMI device. The HMI device then
switches autonomously to "Transfer" mode. Transfer mode may cause undesired reactions in
the system.
After the commissioning phase, disable the automatic transfer function to prevent the HMI
device from switching inadvertently to transfer mode. To block access to the transfer settings
and thus avoid unauthorized changes, assign a password in the Control Panel.
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Network settings
The following tables show the network settings of each product which you need in order to
analyze the network security and for the configuration of external firewalls:
WinCC Basic (without simulation)
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

ALM

4410*

TCP

Inbound,
Outbound

License service

This service provides the complete functionali‐
ty for software licenses and is used by both the
Automation License Manager as well as all li‐
cense-related software products.

HMI Load

1033

TCP

Outbound

HMI Load
(RT Basic)

This service is used to transmit images and
configuration data to Basic Panels.

* Default port that can be changed by user configuration

WinCC Simulation for Basic Panels
Name

Port num‐ Transport
ber
protocol

Direction

Function

Description

HMI Load

1033

TCP

Inbound

HMI Load
(RT Basic)

This service is used to transmit images and
configuration data to Basic Panels.

EtherNet/IP

44818

TCP

Outbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

2222

UDP

Inbound

Ethernet/IP
channel

The Ethernet/IP protocol is used for connec‐
tions to Allen Bradley PLCs.

Modbus TCP

502

TCP

Outbound

Modbus TCP
channel

The Modbus TCP protocol is used for connec‐
tions to Schneider PLCs.

RFC 1006

102

TCP

Outbound

S7 channel

Communication with the S7 controller via
Ethernet/PROFINET

Mitsubishi MC

5002

TCP

Outbound

Mitsubishi MC
channel

The Mitsubishi protocol is used for connections
to Mitsubishi PLCs.

See also
http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)

3.2

News

News about the TIA Portal
You can learn about the latest news about various topic areas of the TIA Portal in Siemens
Industry Online Support.
All news concerning WinCC can be found here: News (http://support.automation.siemens.com/
WW/view/en/88360672)

44

Readme
Programming and Operating Manual, 12/2014

WinCC Basic
3.3 Notes on use

3.3

Notes on use

Contents
Information that could no longer be included in the online help and important information about
product features.

Copying HMI devices with HMI connections
If you copy an HMI device with HMI connections to a PLC, the HMI connection in the new HMI
device is not automatically connected to an existing PLC with the same name. This applies to
copying within a project as well as copying across projects.
To access the PLC tag via HMI tag in the new HMI device, you have to complete the
configuration of the HMI connection immediately after copying. Proceed as follows:
1. Open the "Devices & Networks" editor.
2. Connect the new HMI device to the desired network.
3. Open the connection table.
4. Select the HMI connection of the new HMI device.
5. Select the desired PLC under "Partner".
If you compile the new HMI device or connect additional PLC tags in between copying the HMI
device and completing the connection, there may be some instances in which an additional
HMI connection to the same PLC is created. This is especially true if you connect HMI tags
with DB array elements.

Device replacement
After an HMI device has been replaced, you should check the appearance of the configured
screens. Changing the size of the display may result in changes to the position and appearance
of screen objects, e.g. recipe view and alarm view.

Device replacement - communication
If an HMI device is replaced, error messages of the type "... are not supported in the new
configuration. and will therefore be removed" may be generated. These alarms refer to
configured connections of the device and are triggered, for example, if the HMI devices have
a different number of interfaces. These connections are marked red after a device replacement.
If you would like to continue to use these connections, you have change the configuration of
the connection. Proceed as follows:
1. Open the "Devices and Networks" editor.
2. Click "Network" in the toolbar of the network view.
3. Network the interface of the HMI device with the interface of the CPU.
4. Click in the table area of the network view on the "Connections" table.
5. Select the connection marked red.
6. Enter the new interface under "Properties > General > Interface" in the Inspector window.
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Specifying the time of modification in the overview window
The times of modification displayed in the overview window only refer to changes to the object
itself. Changes to subordinate objects, e.g. screen objects in a screen, do not cause the time
of the last change to the screen to change in the overview window.

HMI device wizard
When you create a device with a color display using the HMI device wizard, the graphics of
the navigation buttons may be displayed in black and white. This error only occurs, however,
if the new device is created with the same name as a device with a monochrome display which
has been deleted in the meantime.
You can avoid this error by always deleting the associated graphics in the Graphics collection
whenever you delete a device from the project.

Objects with object references in the project library
Two copying methods can be used in WinCC flexible.
● With "simple copy" a WinCC flexible screen including an IO field, for example is copied.
Only the object name of a tag configured on the IO field is copied, as this is a reference.
● With "copy", a screen, an IO field contained there and a tag configured on the IO field
together with its properties are copied.
These two methods can also be used for storing an object in a library. Project libraries and the
objects contained there are migrated during migration and can be used in WinCC.
In WinCC, however, only one copying method is available. With regard to tags, it functions like
"simple copy" in WinCC flexible. With regard to graphics, graphics lists and text lists, it functions
like "copy" in WinCC flexible.
If you stored objects with references to tags in a library in WinCC flexible, you must reconfigure
the referenced objects when using them in WinCC.

Installing East Asian project languages on a PC without Asian operating system
If you select an East Asian project language on a PC that does not have an Asian operating
system installed, the default font is marked as invalid in the "Runtime settings > Language &
font" editor.
To resolve this problem, open the "Regional and Language Options > Languages" dialog in
the Control Panel and enable the "Install files for East Asian languages" option.

Installation sequence for Startdrive
When you install Startdrive on a PC, adhere to the following installation sequence:
● Install STEP 7 V13.0.
● Install Startdrive.
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Compatibility with V12 and V13
Empty projects are installed in the installation directory under ..\Portal V13\SampleProjects to
allow the TIA Portal to be opened in compatibility mode:
● V12.0.1.4 project with the name "TIA_Portal_Project_V12.0.1.4.ap12", so that TIA Portal
V13 SP1 can be opened in V12 compatibility mode
● V13.0.0.3 project with the name "TIA_Portal_Project_V13.0.0.3.ap13", so that TIA Portal
V13 SP1 can be opened in V13 compatibility mode
This project must be copied to a local directory with full access before it can be used. For more
information on this, refer to FAQ ID 66027369.

File browser on a Windows 8 PC with touch screen
You can only operate the file browser dialog with a mouse, keyboard or on-screen keyboard
(without using the touch function) on a Windows 8 PC with touch screen. We recommend using
the file browser dialog of the Windows operating system with the help of a script on a touch
screen PC with Windows 8.

Making characters available for HMI tags of the type WString/WChar
You define a string with which certain fonts can be displayed in a tag of the type WString or
WChar. All characters used in the project are available to you.
When compiling the project, only the characters of a font that are actually used in the project
are retained. Unused characters are removed when the project is compiled.
To be able to use fonts that are not installed on a panel, make the characters available as
configured texts in a screen.
1. Create a new screen.
2. Insert a text box.
3. In the properties of the text box, set a font that contains characters that you wish to use
later.
4. Insert the characters of the font that you wish to use later into the text box.
After the project is compiled, you can use the characters configured in the text in HMI tags of
the type WString/WChar.

3.4

Migration

Contents
Information that could no longer be included in the online help and important information about
product features.
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Project languages in WinCC
WinCC V13 does not support all project languages that were available in WinCC flexible, such
as Arabic. If you receive an empty project as the result of your migration, you may want to
check the set editing language. Do not set the project languages that are not supported as
editing language in the source project. Proceed as follows:
1. Open the project with WinCC flexible.
2. Change the editing language to English, for example.
3. Save the project.
4. Restart the migration.

Migrating an integrated project with ProTool objects
The "PROTOOL option package(s) missing in STEP 7" error message output during migration
of a WinCC flexible project that is integrated in STEP 7 indicates that WinCC flexible 2008
SP3 is installed on your system. Moreover, the project still contains objects that were
configured using ProTool. Do not open the project with WinCC flexible 2008 SP3! Proceed as
follows to migrate the project:
1. Copy the project to a computer on which WinCC flexible 2008 SP2 and STEP 7 are installed.
2. Open the project in the SIMATIC Manager.
3. Remove all ProTool objects from the project.
4. Execute the "Save as" command in the "File" menu.
5. Enable the option "With reorganization" in the "Save project as" dialog.
6. Click OK.
7. Copy the project back to the original computer.
8. Restart the migration.

Migrating a WinCC V7 project: Border line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1"
and "Draw insider border = yes".
You then migrate the WinCC V7 project to WinCC V13. To have the rectangle displayed
correctly, follow these steps.
1. Open the Inspector window of the rectangle.
2. Open the property list.
3. Disable "Widen border line inwards".

Progress bar
As long as the progress bar still shows a value of 100%, the software is still busy running
remaining tasks such as the closing of references. The software will not respond to user input
while this status is given.
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Open a project created with WinCC V11
When you open a V11 project with a WinCC V13 version, it is no longer be possible to open
this project with an older version afterwards.

Managing third-party ActiveX controls
The migration also supports third-party ActiveX controls. However, the controls must be
registered in the operating system. If an ActiveX control is not registered, migration is canceled.
If you save a project with the migration tool and perform the migration yourself on another PC,
the controls must also be registered on this PC.

Migrating integrated projects with alarm views
An alarm view is enabled with all alarm classes in an integrated project. The alarm classes are
disabled during migration of the project.
Once the migration of the project is completed, check the settings in the alarm view.
Enable the require alarm classes in the Inspector window of the alarm view if needed under
"Properties > General".

Migrating more extensive projects from WinCC V7
We recommend the use of a 64-bit operating system for the migration of more extensive
projects from WinCC V7.
To use the migration tool on a computer with a 64-bit operating system for large projects, start
the tool via the command line with the parameter 64-bit, as in the following example:
C:\Program Files (x86)\SIEMENS\Automation\MIGTOOL_V13\Bin
\Siemens.Automation.MigrationApplication.exe 64bit

Migrating projects from WinCC V7
In TIA Portal V13, you can continue to use projects from WinCC V7.2 after migration. Projects
from earlier WinCC versions cannot be migrated directly to WinCC TIA Portal version V13. If
you wish to continue using such projects in TIA Portal V13, you must first migrate them to the
WinCC V7.2 Classic page. To do so, use WinCC V7.2 with the latest update.

Migration log
As of TIA Portal V13.0 alarms are sorted into a tree structure in the migration log. This means
all alarms that are part of a specific subsystem are stored in one folder. The result is an increase
in the number of folders in the tree structure. Press the shortcut <NUM+ X> to expand the
currently selected folder and all subfolders in one single step.
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Restrictions for user-specific project data
1. Folders and files you have created in the WinCC V7.2 project directory are not copied to
the new project directory during the migration. You must adapt all scripts that access such
directories and files after the migration.
2. C standard functions of WinCC V7 are not migrated. If you have made changes to the C
standard functions in the WinCC V7 project, you must apply these changes manually to
the TIA Portal after the migration.

Migration of texts in Spanish (international sorting) and Spanish (traditional sorting)
If the WinCC V7 project includes texts in Spanish (traditional sorting), these texts are migrated
as Spanish (Spain) in WinCC V13.
If the WinCC V7 project includes texts in Spanish (international sorting), these texts are
migrated as Spanish (Spain) in WinCC V13.
If the WinCC V7 project includes texts in Spanish (international sorting) as well as Spanish
(traditional sorting), only the texts from Spanish (traditional sorting) are migrated as Spanish
(Spain) in WinCC V13. The texts from Spanish (international sorting) are not taken into
consideration.

See also
Object support during migration
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3.5

Engineering System

3.5.1

Screens and Screen Objects

Contents
Information that could no longer be included in the online help and important information about
product features.

Screen objects after HMI device replacement
If you upgrade a device to the new HMI device versions, you should check the screens
contained in the project. Because of the new appearance and improved operability, texts of
symbolic I/O fields may not be completely legible and may be concealed by operator controls.

Copying display objects between two projects or two devices
In Project_1 configure an alarm window in the Global Screen, for example. You copy the alarm
window and paste it in the Global Screen in Project_2.
The enabled alarm classes are partly not enabled in the alarm window after pasting.
This behavior applies to the following display objects:
● Alarm window
● Alarm indicator
● Alarm view

Display of the cross-references in the Inspector window
The Inspector window displays objects used by a screen object in the "About > Crossreference" tab.
A screen is open and an object selected. You are using an HMI tag at the object as process
tag.
The object and the linked HMI tag are displayed in the cross-references. All locations of use
of the object and the HMI tags are listed.
If the HMI tag is interconnected with a PLC tag or a DB tag, the locations of use of the
interconnected PLC tag or DB tag are displayed.

Readme
Programming and Operating Manual, 12/2014

51

WinCC Basic
3.5 Engineering System

Event names in case of alarms in the "Info" tab of the Inspector window
In some alarms of the Inspector window the event names in the "Info" tab will deviate from the
names in the "Properties" tab.
Name in the "Properties" tab of the Inspector win‐ Name in the "Info" tab of the Inspector window
dow
Cleared

ClearScreen

Loaded

GenerateScreen

Enable

Activate

Change

Change

When a dialog is opened

ONMODALBEGIN

When a dialog is closed

ONMODALEND

User change

PASSWORD

Screen change

SCREEN

Disable

Deactivate

Press

Press

Outgoing

Going

Incoming

Coming

Limit "high limit error" violated

AboveUpperLimit

Limit "low limit error" violated

BelowLowerLimit

Click

Click

Loop-in alarm

LoopInAlarm

Release

Release

Alarm buffer overflow

OVERFLOW

Acknowledge

Acknowledgement

Runtime stop

Shutdown

Press key

KeyDown

Release key

KeyUp

Toggle ON

SwitchOn

Toggle OFF

SwitchOff

Value change

Change value

Faceplates
Faceplates cannot be rotated or mirrored.

Tab sequence in screens with faceplates
If you have configured a tab sequence in screens with faceplates in WinCC V12 or WinCC
V12 SP1, you should check the tab sequence of these screens in WinCC V13. The tab
sequence may have been changed in both the screen and the faceplate.
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Tag prefix of a screen window in WinCC Runtime Professional
The objects of the "Controls" palette do not support the tag prefix that can be configured for a
screen window.

I/O field with "decimal" display format and format pattern without "s" prefix
You have linked a process tag to an I/O field. The I/O field is assigned the "decimal" display
format.
You may select a signed or an unsigned display format.
A "Format pattern" setting without "s", e.g., "999" has the following effects:
1. You cannot set negative values using the I/O field in Runtime.
2. If the tag assumes a negative value, the I/O field generates a two's complement and a
corrupted positive value is output.

Trend view on Basic Panels
The trend view buttons are not displayed on Basic Panels. You can operate the trend view
using the function keys of the HMI device that are assigned corresponding system functions.

Grouping of screen objects
When you group screen objects in WinCC, performance problems can arise in WinCC in the
case of large nesting depths.

ActiveX and .NET controls
ActiveX and .NET controls are always positioned in the foreground in runtime.
The configuration of ActiveX and .NET controls on levels is not supported.

Use of bitmaps as icons
In Windows 8 and Windows 8.1, the use of bitmaps with a size of 48x48 pixels and a color
depth of 32 bits as icons is not supported.

Border line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1"
and "Draw insider border = yes".
You then migrate the WinCC V7 project to WinCC V12. To have the rectangle displayed
correctly, follow these steps.
1. Open the Inspector window of the rectangle.
2. Open the property list.
3. Disable "Widen border line inwards".
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Border line of “Graphic I/O field" object
In WinCC V13, the dynamization of the border line of the "Graphic I/O field" object in "Two
states" mode has no effect during runtime.

Dynamization of instances of a faceplate type in a group
You are using the instance of a faceplate type in an object group. The properties of the instance
are also displayed as properties of the group. Any dynamization with tags, scripts or animations
of the group is not displayed in Runtime.

Preview in screen window
You use your own designs with shadows for screen objects. The screen objects can be
displayed in a screen window.
The shadows of the screen objects are not displayed in the preview of the screen window. The
response occurs only in the engineering system. It is displayed correctly in Runtime.

Assigning graphics to a softkey
A graphic can only be assigned to a softkey if the bottom edge of the permanent window does
not conceal the area of the softkey graphic.

Renaming a PLC in Runtime
If a PLC is connected to the PLC code viewer in WinCC Professional and Runtime is running,
changing the name of the PLC during runtime will trigger a error. Do not change the PLC name,
the IP address, or other properties of the HMI connection during runtime.

Panels and RT Advanced with device version V13: many visually different screen objects
The use of screen objects with very many visually different properties (e.g., very many different
styles) can reduce the performance of the user interface in Runtime and can increase the
amount of available memory space used. Avoid using, for example, very many different corner
radii: 0 pixel, 1 pixel, 2 pixels, 3 pixels, etc.
The use of many differently sized “Gauge” objects can have the same effect. Avoid “Gauge”
of height 48 pixels, 49 pixels, 51 pixels, etc. Instead, use sizes such as: 50 pixels, 70 pixels,
100 pixels.

Dynamization of grouped objects
For groupings with multiple nestings (group in group, faceplate in group, group in faceplate,
etc.), only the events of the outermost group and the innermost objects can be used for
dynamization with system functions. System functions that are configured at events of the
lower-level group or lower-level faceplate are not executed.
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Number of characters in text fields, lists and alarm texts
The number of available characters in the text of a screen object is dynamic and depends on
the HMI device and the memory format. Control instructions and formatting are taken into
consideration when entering text data and the maximum number of characters is reduced
accordingly.

Transparency in WinCC V13
Transparent graphics can be displayed without any problems in Runtime. This is true for all
Comfort Panels and WinCC Runtime Advanced with version 13.0.0.0.
To use the transparency in a graphic view or in a graphic I/O field, the "Fill pattern" property
must be set to "Transparent" and the property "Use transparent color" must be disabled.
If the property "Use transparent color" is enabled in a device with version 13.0.0.0, the
transparency of the graphic is lost and the transparent pixels are displayed in black. We
recommend that you check the "Use transparent color" property at the points of use of
transparent graphics after upgrading existing projects to device version 13.0.0.0. If the graphics
are not displayed correctly, disable this property.

Addressing tags in the "PLC code display" object
The "PLC code display" object only supports symbolic addressing of tags. If the operand is
not addressed symbolically, the network with the operands cannot be displayed and an error
message is generated.

Characters that can be used in the property name of the screen blocks with RT Professional
Note the following rules when entering property names of the faceplates:
● The name must start with a letter.
● The name can contain alphanumeric characters and the underscore.
● The name may not contain more than 255 characters.
● Do not use any UNICODE characters (for example, Chinese characters).

Playing videos on Comfort Panels
You can play video sequences on Comfort Panels in the "Media Player" screen object. You
can find more detailed information on playing videos on the Internet under:
http://support.automation.siemens.com (http://support.automation.siemens.com/WW/view/en/
62101921) (entry ID 62101921)

Selecting the transfer protocol for the camera view
To display the screens of a network camera in the camera view, define the transfer protocol
in the properties of the screen object. Select the TCP or UDP transfer protocol depending on
your network and the type of network camera you are using. In most cases, a TCP connection
has reliable synchronization with the camera view.
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Displaying SIMOTION PLC websites in the HTML browser
If the SIMOTION PLC websites are not displayed correctly in the HTML browser, insert "/basic"
after the website URL to display the websites in basic mode.

Using the optional "CamControls" from older TIA Portal versions
If you want to continue using the control "CamControl" from older versions of TIA Portal
configurations in TIA Portal V13 SP1 or newer, we highly recommend an update of the TIA
Portal project version and HMI device version to V13 SP1.

Basic Panels: Animation of object groups
Basic Panels as of device version V13 SP1 support animation of object groups that consist of
individual screen objects. Animation of nested groups is not supported, however.

RT Professional: Copying screen objects with linked user data types
After copying a screen object from a screen that uses a user data type to a screen that does
not use a user data type, the tag references in the target screen are shown with the prefix
"@NOP::". These tag references do not function during runtime if the target screen is to be
shown in a screen window. If you want the tag references to function, interconnect the target
screen temporarily to a user data type. The interconnection of the target screen to the user
data type can then be deleted afterwards.

RT Professional: User data types linked to screen objects in faceplates
If a faceplate uses an element of a user data type and a faceplate is created from this screen
object, all tag references in the faceplate are shown as "@NOP::". The tag references function
during runtime despite this, however. For the tag references to be shown correctly, no element
of a user data type should be used when creating a faceplate from an existing screen object.

Display differences between the configuration and the display on the HMI device
The display of the text configured in a screen object may be different on the HMI device due
to the display configuration. If you are using the options for automatic size adjustment in the
configuration, check the display on your HMI device in every language.
If texts that were configured with the "Fit object to contents" option cannot be displayed in full,
they are reduced slightly on the HMI device. If this reduction leads to a distorted display of
texts, disable the "Fit object to contents" option and expand the text with additional blanks.
Optionally, you can increase the width of the object or use a shorter formulation for the text.

RT Professional: S7-GRAPH overview
If the name of the S7-GRAPH data block that is interconnected at an S7-GRAPH overview
contains a period, the control does not work during runtime.
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Migration and configuration of ActiveX controls
Changes to properties of ActiveX controls are only saved if the control synchronizes the
OCXState property correctly in the case of changes.
For controls such as "Microsoft Date and Time Picker Control" that do not synchronize the
OCXState property correctly, the changes are discarded after the screen is closed, during
compilation or after the migration.

Exporting and importing function keys
Function keys are synchronized during the import. If a function key is created in the global
screen and the key is empty in the screen, the corresponding function key will use the global
definition in all screens.
If you want to disable the global use of function keys after the import, define empty keys in the
screens and import the screen types in the following order: Global screen, templates, screens.
If you want to ensure when exporting the screens that the global definition of a function key is
not used by the template or by the global screen, create an empty function key in the screen.
Select the required function key in the screen, then enable the "Use global assignment"
property and disable it again.

3.5.2

Tags and connections

Contents
Information that could not be included in the online help and important information about
product features.

Display of deleted array elements at location of use of HMI tags
The locations of use of HMI tags, such as the process value of IO fields, are usually indicated
by the tag name. If the element of an array tag is used, then the tag name will be extended by
the index of the array element indicated in brackets.
If a used tag is no longer included in the project, then the tag name will still be displayed at the
location of use. The field will be displayed with a red background to indicate the missing tag.
If a used array element or the array tag is no longer present, then only the index of the array
element will be displayed in brackets. The tag name will not be displayed. The field is
highlighted in red. You can no longer identify the name of the associated array tag based on
the location of use in this instance.
If you do not know which array tag was linked to this location of use, then it may be necessary
to link the array element once again.
If a tag or array tag was created based on a reference, then the selected reference will be
closed automatically.
If an HMI tag is connected with an array element of a PLC tag and the PLC tag does no longer
exist in the project, then the same behavior will take place in the "HMI tags" editor.
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Array tags as list entry of multiplex tags
You can use the array tags of the Char data type just like the tags of the String data type.
The use of an array tag of the Char data type as list entry of a multiplex tag in the "HMI
tags" editor is not supported.

Multiplexing tags on a Basic Panel
If you multiplex a tag with an external tag on a Basic Panel, the address is read from the PLC
in runtime during the first read cycle. The value of the address read is not available until the
second read cycle.

Runtime Advanced and Panels: Importing array elements and structure elements
Array tags and structure tags are always imported in full with all elements. The elements of
the array tags and structure tags are not filled further during import.
A new tag is created if the name of a tag corresponds to the name of an array or structure
element in the import file.
Example:
The import file contains an array tag called "Otto" with 10 array elements. The array elements
are then called Otto[1], Otto[2], for example.
If the import file contains a tag named "Otto[1]", the first element of the array tag will not be
filled. Instead, a new tag will be created in the engineering system.

Local ID of HMI connections
You cannot edit the "Local ID" value in the HMI connection properties. You need the local ID,
for example, for communication by way of AR_SEND. To enable usage of the "Local ID" for
communication, proceed as follows:
1. Open the network view in the "Devices & Networks" editor.
2. Click "Connections".
3. Select an S7 connection.
4. Select the "Add new connection" command in the shortcut menu of the PLC.
5. Click on the interface.
6. Specify the "Local ID (hex)".
7. Click "Add" and then "Close".
8. Select "Properties > General" from the partner area of the Inspector window and enter the
IP address of the HMI device for the new connection.
9. Configure the necessary raw data tags for communication in the HMI device.

Tags with the DTL data type
Tags that use the "DTL" data type element by element, can only be used as read-only.
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Tag names in faceplates
Use of the "." or "@" character in names of tags in faceplate types is not permitted. Do not use
these special characters in the tag names in faceplates.

RT Professional: Tags with symbolic addressing and "Char Array" data type
Tags with symbolic addressing and the "Char Array" data type are not released for
communication of RT Professional and SIMATIC S7-1200 V3.

Array elements in WinCC
If you have connected an HMI tag with an array from a STEP 7 data block which does not start
with a low limit of 0, the array elements are mapped in WinCC to the low limit of 0.
To ensure that you do not have to rethink between the STEP 7 indices and the WinCC indices
when accessing the individual array elements, the low limits of arrays should also start at 0 in
STEP 7.

Duration of the initialization of historical data
Initialization of the archives on some storage media can take up to 5 minutes. The successful
completion of initialization is confirmed by a system message once it has been completed. If
there a lack of any storage medium for archiving when Runtime starts, the appearance of the
system message can also take up to 5 minutes.

3.5.3

Alarm system and alarm displays

Contents
Information that could not be included in the online help and important information about
product properties.

Displaying special characters in alarm texts
When configuring alarm texts, a fixed character set is used in the Engineering System. This
character set allows you to use numerous special characters in alarm texts.
Language-dependent fonts are used in runtime to display the texts, for example MS PGothic,
SimSun. The fonts used in runtime do not support all special characters. As a result, some
special characters are not displayed in runtime.

Use of multiplex tags in output boxes with alarm texts
It is also possible to use multiplex tags in the output boxes of alarm texts in the engineering
system. During runtime, this leads to an incorrect display of the alarm, because the use of
multiplex tags is not supported by the basic panels.
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Parameters in user alarms
Contrary to the information in the online help, it is not possible to configure parameters for user
alarms.
The menu command "Properties > Properties > Alarm parameters" is not available in the
Inspector window.

Tags in alarm texts of Runtime Advanced
Tags of data type WChar or WString cannot be displayed in the alarm view in Runtime
Advanced.

Boolean tags in alarm logs
Bool type tags are recognized as 0 and -1 in the alarm log. If you use a text list that is controlled
by a tag of the type Bool in an alarm log, then add the entry for the value -1 to the corresponding
text list.

Duration of the initialization of historical data
Initialization of the archives on some storage media can take up to 5 minutes. The successful
completion of initialization is confirmed by a system message once it has been completed. If
there a lack of any storage medium for archiving when Runtime starts, the appearance of the
system message can also take up to 5 minutes.

Printing alarms in Runtime
In WinCC, only ASCII characters are supported when printing alarms directly in Runtime.

3.5.4

System functions

Content
Information that could not be included in the online help and important information about
product properties.

The "SimulateTag" system function on Basic Panels
If you use the system function "SimulateTag" with a short cycle time on a Basic Panel, the HMI
device may be overloaded.
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3.5.5

Recipes

Contents
Information that could not be included in the online help and important information about
product features.

Arrays in recipe elements
If you have configured both an array as well as the elements of this array for recipe elements
of a recipe, the loading of data records aborts with the following error message: "290055: Import
of data records aborted with error"
Use either the array or just the array elements for recipe elements of a single recipe.

3.5.6

User administration

Contents
Information that could no longer be included in the online help and important information about
product features.

Encrypted connection with SIMATIC Logon V1.5 SP3
Secure encrypted communication between SIMATIC Logon and HMI operator devices is
supported as of SIMATIC Logon version V1.5 SP3 and the HMI device version V13 SP1 for
Comfort Panels, KTP Mobile Panels and RT Advanced.
HMI devices with a version V13 or earlier can only make an non-secure / non-encrypted
connection to a SIMATIC Logon server.

Authentication and certificate management in SIMATIC Logon
If you want to use a secure encrypted connection, the first time a connection is made the
SIMATIC Logon certificate is compared with the local certificate of the HMI device. Only when
the comparison has been successfully performed can a secure encrypted connection be
successfully established.
When you make a connection the first time, the compared certificate is stored under
"SimaticLogon\rejected". If you trust the certificate of the server, copy the stored certificate into
the local certificate store directory.
The certificate store is located in the following path:
● On the PC under "C:\Program Files\Siemens\CoRtHmiRtm\SimaticLogon\certs"
● On HMI panels under "\flash\simatic\SimaticLogon\certs"
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Dynamic logon
In Runtime Professional, an automatic log-off time does not affect users that log on via a logon
tag.

3.5.7

Communication

Contents
Information that could no longer be included in the online help and important information about
product features.

Connection interruptions with Mitsubishi PLCs
After multiple connection interruptions, a situation may arise where all the connection
resources of the Mitsubishi PLC are in use and the connection can no longer be established.
It is recommended to check these connection resources in the PLC program of the PLC and
also to enable them again.

Limited number of possible HMI connections
An error message is displayed during compilation of a device indicating that the configuration
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that
the maximum number of possible connections of the HMI device or PLC has been exceeded.
Check the maximum number of available connections. Consult the device manuals of the
devices you are using.

Communication by means of routing with S7 300/400
Communication of connection partners in different subnets is possible via routing with the
following connections: PROFINET, PROFIBUS, MPI.

Use of PROFINET IO with panel HMI devices
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC,
you can define an offset for the address area of the inputs and outputs during configuration in
HW Config.
The following restriction applies when a PROFINET IO-capable S7-400 CPU is used with one
of the HMI devices listed below:
The offset for the start of the address area of the inputs must not be greater than the offset for
the start of the address area of the outputs.
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The restriction applies to the following HMI devices:
● OP 177B
● OP 277
● Mobile Panel 177
For the configuration of the address parameters, open the PLC with the S7-400 CPU in HW
Config. Select the HMI device connected via PROFINET IO in the station window of HW Config.
A table with the properties of the HMI device is displayed at the bottom of the station window
in the detail view. Select the line containing the addresses of the HMI device in the table and
open the object properties using the shortcut menu.
Enable the "Addresses" tab in the "Object properties" dialog. Configure the offset for the inputs
under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start".

Exceeding value ranges with Mitsubishi MC and Mitsubishi FX
With some data types, the Mitsubishi MC and Mitsubishi FX communication drivers do not
check whether the value of a recipe tag exceeds the value range of the PLC tags. The data
types affected are:
● 4-bit block
● 12-bit block
● 20-bit block
● 24-bit block
● 28-bit block

Coordination area pointer in an OPC connection
In principle, the coordination area pointer can be used eight times in an OPC connection. If
you have configured an OPC connection and you automatically create another OPC
connection using "Add", the coordination area pointer is only displayed once in the newly
created connection. In this case, you should change the communication driver of the
connection. If you then set OPC again as the communication driver, the coordination area
pointer can again be used eight times.

Changing IP settings and device name of a PLC in the Control Panel of the HMI device
The Control Panel is open in the "Service and Commissoning > IP-Adaptation" menu on the
HMI device. If you want to change the IP settings or the device name of a PLC, note the
following:
In the Engineering System, you need to have activated the following options in the Inspector
window of the PLC under "Properties > General > PROFINET interface > Ethernet addresses"
beforehand:
- "Set IP address using a different method" and
- "Set PROFINET device name using a different method".
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HMI connections in WinCC V13
HMI connections to SIMATIC S7-1200 PLCs with firmware versions earlier than V2.0 are not
possible in WinCC V13.

Connections via PROFIBUS DP
When a connection between a PLC and an HMI device via PROFIBUS DP is interrupted and
then re-established, sporadically all other PROFIBUS DP connections in the communication
network are interrupted and re-established.
De-energize the disconnected station before reconnecting it.

"Set the IP suite (address) of the PLC in the Control Panel" with SIMATIC S7-1200 V1
The function "Set the IP suite (address) of the PLC in the Control Panel" has not been approved
for the following PLCs:
● SIMATIC S7-1200 V1

Switching a connection
A connection may be interrupted when it is switched from an HMI device to a SIMATIC
S7-300/400, to a SIMATIC S7-1500 or to a SIMATIC S7-1200 PLC.
Note the following settings in the SIMATIC S7-1500 or SIMATIC S7-1200 controllers:
● Absolute addressing of tags
● The "Disable PUT-GET communication" option must be selected
● The "Complete protection" protection level may not be set

Raw data communication in redundant projects
Simatic.NET, Named Connections and various communication blocks, such as BSEND/BRCV,
for example, can only be used to a limited extent in a redundantly configured PC station
because the connection parameters for the redundant partner server cannot be configured.

Non-integrated connection to a SIMATIC S7-1500 software controller
A non-integrated connection between an HMI device and a SIMATIC S7-1500 software
controller is not supported in WinCC.

3.6

System-wide functions

Contents
Information that could no longer be included in the online help and important information about
product features.
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Using system diagnostics in the device proxy
To use the system diagnostics function in an IPE device proxy, for example, a system
diagnostics view, insert the PLC alarms as content of a device proxy.

Importing and exporting project texts
In WinCC, you only import the previously exported project texts into the same project. Importing
into a different project is not supported.

Initialize device proxy with data from a V13 project
You cannot initialize a device proxy with data from a V13 project in a project with the version
V13 SP1.
Upgrade the V13 source project to version V13 SP1 to initialize the device proxy in the target
project with the data from the source project.

3.7

Compiling and loading

Contents
Information that could no longer be included in the online help and important information about
product features.

Compiling and loading
If internal errors or warnings occur during compiling, compile the complete project using the
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device.
Before you start productive operation with your project, compile the entire project using the
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device.
If you are using HMI tags that are connected to the control tags in your project, compile all
modified blocks with the command "Compile > Software" in the shortcut menu before you
compile the HMI device.

Settings for update of operating system
If you select the command "Online > HMI device maintenance > Update operating system"
from WinCC, you cannot change the settings such as the type of PG/PC interface or baud
rate. The settings used during the last download are always used.
To make changes to the settings, open the "Extended download to device" dialog using the
"Online > Extended download to device" command and change the settings. When you click
the "Load" button the changed settings are saved.
Alternatively, you can perform an update of the operating system with changed settings with
ProSave. You start ProSave via the Windows Start menu "Siemens Automation > Options and
Tools > HMI Tools > SIMATIC ProSave".
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Incorrect installation of ProSave
If you receive an error message during installation of ProSave when loading data to a target
device or maintenance of an HMI device, then you cannot remedy this error using the repair
function of setup. Remove ProSave via the Control Panel. Then start setup and install the
"ProSave" component again.

Checking the address parameters
During compilation of an HMI device in the project tree with the command "Compile > Software"
in the shortcut menu, the address parameters of the HMI device, such as the IP address, will
not be checked. If you want to ensure that the address parameters are checked as well, you
will have to compile the HMI device using the "Compile" button in the "Devices & Networks"
editor of the toolbar.

Error message when downloading data to the PLC
A panel and a PLC are connected and communicating with other.
If a tag is accessed while downloading data from the panel to the PLC, an error message is
displayed on the panel.

Delayed reaction in the "Extended download to device" dialog
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface"
and "PG/PC interface" do not match the settings on the HMI device, this can result in the
application not responding for up to a minute.

Extended download with an S7-1200 and a Comfort Panel
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the PG/
PC. You open the "Extended download to device" dialog for the Comfort Panel.
If you enable the option "Show all accessible devices", it may occur that the application stops
responding.

OP77A, OP73, TP177A: Loading projects
When loading a project to an HMI device, it can happen that Runtime is not automatically
ended, even though "Remote Transfers" is activated in the Panel.
If this happens, stop Runtime and manually set the transfer mode on the HMI device.
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Loading a SIMATIC HMI application to a PC station
The following circumstances can lead to an error message during the first load of a SIMATIC
PC station:
● A SIMATIC HMI application is configured in a PC station in the project
– WinCC Runtime Advanced
– WinCC Runtime Professional
– WinCC Standby
– or WinCC Client
● The property "S7RTM is installed" is activated.
Before you load a SIMATIC PC station for the first time, select the configured device HMI_RT
(WinCC...) in the project tree. Open the "Extended download to device" dialog and select the
appropriate interface and parameter settings. Click "Load".
You then load the PC station as normal.

Project transfer via USB
If you have connected more than one HMI device via USB to your configuration PC, project
transfer is only possible to the last connected device.

Opening project files
When you run "HmiIRTm.exe", a dialog opens asking if you want to open the project file (.fwc).
The following options are available to you:
● "Yes": A dialog opens allowing you to select a project file (.fwc).
● "No": The dialog closes.

Tag simulator in WinCC Professional does not start
If the tag simulator does not start in WinCC Professional, it may be because the fm20.dll file
has not been installed in the system yet. The fm20.dll file cannot be distributed and must be
installed as part of a Microsoft application:
http://support.microsoft.com (http://support.microsoft.com/default.aspx?scid=kb;EN-US;
224305)
You have the following two options for installing the fm20.dll file:
● Install an application, such as Microsoft Office 97, on the destination system. The
installation routine also installs the fm20.dll file.
● You can also download and install the Microsoft ActiveX Control Pad free of charge. The
fm20.dll file is also installed in this case. Additional information on the ActiveX Control Pad
is available on the Microsoft Developer Network website:
http://msdn.microsoft.com/en-us/library/ms968493.aspx (http://support.microsoft.com/
default.aspx?scid=kb;EN-US;224305)
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Error message when PLC is loaded with a newer version of the TIA Portal
PLC code display shows the current program status of PLC programs.
An error message is output if the PLC code display from an older version of WinCC accesses
a program on the PLC loaded with a new version. Make sure that the PLC and the HMI are
loaded with the same version of the TIA Portal.

Comfort panels as of device version 13.0: Backing up data while loading projects
If the transfer is interrupted for Comfort Panels with a device version 13.0 or higher, WinCC
automatically ensures that no data is lost and that existing data is only deleted on the HMI
device after complete transmission.

Loading projects to a file
The "Load project to file" functionality is only available in Runtime Advanced devices with
version V13 or older.

Displaying characters in transfer alarms
If characters are not displayed correctly in the transfer alarms during transfers to HMI devices
with the device version V12 or older, please check the region and language settings in
Windows. Set the corresponding language under "Language for non-Unicode programs".

3.8

Runtime

3.8.1

Notes on operation in Runtime

Contents
Information that could no longer be included in the online help and important information about
product features.

Focus in Runtime
If you have configured a low-contrast combination of focus color and border color in a V12
project, the focus may no longer be identifiable after changing the HMI device version in
Runtime. Change one of the two colors.

Language behavior - Layout of on-screen keyboard
The layout of the on-screen keyboard is not switched when the runtime language changes.
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Tag values exceed the maximum length
You enter a character string in a string tag via an I/O field. If the character string exceeds the
configured number of tags, the character string will be shortened to the configured length.

Empty alarm texts
Runtime is running with a project. The project is saved on a network drive.
In the event of interruptions to the network drive connection, Runtime may attempt to load
alarm texts from the network drive.
In the event of disconnection, the alarm window or the alarm view remains empty.
To avoid this, copy the project to a local drive before the starting the project in Runtime.

Complete download in Service mode
If you need to perform a "complete download" to the OS in Service mode from the engineering
station, Runtime automatically stops and then starts again.
The project is then no longer in Service mode.
In this state, the power supply is interrupted and WinCC Runtime no longer starts automatically
on the OS.
Remedy:
1. Switch the project manually to Service mode after you have performed the "complete
download".
2. Close the project manually.
3. Enable Service mode.
4. Start Runtime again using the surrogate icon in the taskbar.

Slow reaction of SmartServer
The following programs may start and respond very slowly under Windows 7 and Windows
2008 servers:
● HMI TouchInputPC
● SmartServer: <Ctrl+Alt+Del> shortcut in the logon dialog
The delay is caused by the callback for the Internet certificate validation.
Remedy:
You can find the following files
on the product DVD under:
Support\Windows7\CRL_Check or CD_RT\ Support\Windows7\CRL_Check\:
● DisableCRLCheck_LocalSystem.cmd
● DisableCRLCheck_CurrentUser.cmd
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1. Run the "DisableCRLCheck_LocalSystem.cmd" file with administrator rights. Select the
command "Run as administrator" from the shortcut menu of the file.
2. Reboot the PC.
If the problem persists, follow these steps:
1. Double-click the file and run the "DisableCRLCheck_CurrentUser.cmd" file with user rights.
2. Reboot the PC.
Note
The callback for the certificate validation is disabled for all users or PCs. To restore the
original state, perform the following files:
● RestoreDefaults_LocalSystem.cmd
● RestoreDefaults_CurrentUser.cmd
You can find the files in the following directory of the product DVD:
● Support\Windows7\CRL_Check or CD_RT\Support\Windows7\CRL_Check\

Starting Runtime
Only WinCC Runtime V13 can be started in TIA Portal V13. WinCC Runtime V11.02, V12 or
V13 can be simulated in TIA Portal V13.

Avoiding corrupt files during power failure
If a power failure occurs in Windows systems while the WinCC system is active, files may be
corrupt or destroyed. Operation with the NTFS file system provides better security.
Secure, continuous operation is only ensured by using an uninterruptible power supply (UPS).

Blocking task switching on Windows 7 and Windows 8.x
To use the "Block task switching" option on a Runtime PC, disable the Aero theme in Windows
7 and Windows 8.x. To disable the Aero theme, right-click on the Desktop and select
"Personalize". In the "Personalization" menu, select the designs "Windows Basic" or "Windows
- Classic".

3.8.2

Notes on operation of panels in Runtime

Contents
Information that could no longer be included in the online help and important information about
product features.

License transfer via S7USB
You always need to run WinCC to transfer a license to a panel via S7USB.
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Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect
HMI device" menu command is not available in Automation License Manager, open command
line input and run the following command with administrator rights:
"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Using the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels.

Basic Panels, OP73, OP77A and TP177A: Displaying texts in runtime
The default font selected in the "Runtime settings > Languages & font" editor has an effect on
the display of texts in runtime.
Text entries may be truncated if you selected an unfavorable font size or style.
This setting possibly has an effect on the following text entries:
● Tooltips
● long alarm text
● text in the dialogs

Basic Panels: Connections to S7-1200 and S7-1500 with Backup/Restore
If you use the "Backup/Restore" function, a maximum of two connections from Basic Panels
to the controllers are possible at any given time.
● SIMATIC S7-1200
● SIMATIC S7-1500

Basic Panels: Backup on the memory card of the PLC
Create the backup file "A.psb" on the memory card of the PLC. An error, for example a
connection break, occurs when creating the backup.
This will create a corrupt file on the memory card of the PLC. Such a file has "~$" as prefix.
Delete the file with the prefix "~$" if you want to save a backup again under the same name
"A.psb".

Basic Panels: Panel Data Storage and S7-1500F
The "Panel Data Storage" PDS function cannot be used on Basic Panels in conjunction with
S7-1500F when the password for the protection level "Full access incl. fail-safe" is used.
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"Panel Data Storage" function on Basic Panels
The "Panel Data Storage" (PDS) function provided by Basic Panels is only supported by
SIMATIC S7-1200 as of firmware V4.0 and SIMATIC S7-1500. For the PDS function, the panel
must be connected directly with the CPU and must not be connected via the CP.

3.9

HMI devices

3.9.1

Notes on HMI devices

Contents
Information that could no longer be included in the online help and important information about
product features.
If the PC goes into standby or hibernate mode while the transfer is in progress, the panel status
after interruption of the transfer is not defined.

Multi-key operation
Unintentional actions can be triggered by multi-key operation:
● When you are using a key device, you cannot press more than two function keys at the
same time.
● When you are using a touch device, a standard PC or a panel PC, you can only press one
function key or button at the same time.

TS Adapter with Ethernet interface
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory
settings.

Simulation of the Basic Panels
Use an output field in an alarm text to output an external tag. The content of the output field
will always be displayed with "0" during simulation.

Simulation with real PLC connection
The access point used by the simulation is independent from the settings of the engineering
system and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool.
If the PLC connection is terminated right after the start of the simulation with alarm 140001,
you should check the access point used by the simulation with "Setting PG/PC Interface".
1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens.
2. Select" "S7ONLINE" in the "Access point of application" field as standard for HMI.
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3. Select the interface in the "Interface Parameter Assignment Used" area.
4. Exit the dialog "Setting PG/PC Interface" with OK

Loading of projects without recipe data records
You are using recipes in a project. You transfer the project to a Basic Panel without recipe
data records.
You may encounter inconsistencies if you have altered the structure of the recipe in the
engineering system and the device already held recipe data records.
Check the consistency of the data records in this case. The device will not issue a note for all
structural changes.

Floating point numbers on MP 277, MP 377, TP 177B 4'' and CP4
Only floating point numbers in the range from 10-293 ... 10+307 are displayed correctly on the
HMI devices MP 277, MP 377, TP 177B 4'' and CP4. If the tag value is outside this range, it
is displayed as 0.

Mobile Panels V2
If you use Mobile Panels V2 in a project, it is not possible to open the project with WinCC V11
SP1. This affects projects with the following devices:
● Mobile Panel 277F IWLAN (RFID Tag)
● Mobile Panel 277F IWLAN V2
● Mobile Panel 277 IWLAN V2

"Zone ID/Connection point ID" tag of a Mobile Panel 277 IWLAN V2
The tag used for the "Zone ID/Connection point ID" must be of data type INT for Mobile Panel
277 IWLAN V2 devices. Adapt this data type if necessary when migrating a project.

HMI devices with operating system Windows CE 5.0 or higher
Owing to a modified client-server communication security setting, the time difference between
the HMI device (client) and PC (server) must not exceed 1 day. If you back up recipe data from
the HMI device on a network drive, for example, make sure that the time is set correctly on the
PC (server) and the HMI device (client).

HMI devices with high communication load
S7 Diagnostics should be enabled if a Panel is assigned many connections to PLCs or other
HMI devices. Otherwise, you will risk overload on the Panel.
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Device replacement in the engineering system
In the engineering system, you replace a device with configured LED keys with a device without
LED keys. Runtime start fails after you have transferred the project data to the device.
For this reason, delete the LED key configuration before you replace the device.

Restrictions for the HMI device, MP 377 15" Touch daylight readable
The following functions are not supported in WinCC V12 for the MP 377 15" Touch daylight
readable HMI device:
● Option: Sm@rtServer
● System function: SetAndGetBrightness
● Direct keys

Upgrading Basic Panels to WinCC V13
Before you upgrade Basic Panels from version V12 to version V13, transfer the image of the
V12 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings".
In this way, you always start a functional update of the image.
Affected devices:
● KP300 Basic mono PN
● KP400 Basic color PN
● KTP400 Basic color PN

Connection switch in the Control Panel with Basic Panels
If you use the "Override protected connection information" function, the following restriction
applies:
You cannot perform a connection switch in the Control Panel of a Basic Panel from a PLC
without a protection level to a PLC with a "Complete protection" level.

2nd generation Basic Panels: Choosing a USB port
If you are not using a USB hub, select the USB port USB_X60.1 as storage path.

KTP400F Mobile
KTP400F Mobile is available as Hardware Support Package (HSP) for version V13 SP1.

Mobile Panels 277F IWLAN (RFID Tag): F_DB_STATES
The block F_DB_STATES is no longer delivered with WinCC V13 SP1. The block
F_DB_STATES serves only for data exchange. You can configure a block to replicate the
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function of the F_DB_STATES, however. Note the description of the F_DB_STATES in the
operating instructions of your HMI device or in the information system.

F_FB_KTP_Mobile and F_FB_KTP_RNG
The fail-safe function blocks F_FB_KTP_Mobile and F_FB_KTP_RNG are not contained in the
software WinCC V13 SP1. The function blocks will be part of the WinCC V13 SP1 Update for
the Mobile Panels 2nd generation.

Mobile Panels 277F IWLAN
Mobile Panels 277F IWLAN are not released for use with CPUs of the type S7-1500F with
WinCC V13 SP1.
Mobile Panels 277F IWLAN are not released for use with CPs in connection with CPUs of the
type S7-400F with WinCC V13 SP1.
Affected MLFBs: 6AV6645-0EB01-0AX1, 6AV6645-0EC01-0AX1, 6AV6645-0EF01-0AX1,
6AV6645-0GB01-0AX1, 6AV6645-0GC01-0AX1, 6AV6645-0GF01-0AX1.
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